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GENERATE AND MODEL GRANULAR STRUCTURES 

The module GrainGeo creates detailed 3D models of granular structures, sintered 

materials, and sphere packings and pilings with arbitrary object shapes.  

Typical applications are the replication of ceramics, soot particle filters, metamorphic 
rocks, polymer concrete, electrode materials for e.g. Li-ion batteries, to mention only 

a few. In general, the spectrum ranges from powders and piled granular structures 

over sintered materials with open or closed porosity to densely sintered composite 

materials. 

The starting point for modelling a granular structure is to define initial parameters, 
such as grain size distribution, pore size distribution or grain shapes. By starting the 

creation process, randomly distributed grain structures, pilings of various digital 

grains and sphere packings are generated according to these parameters. Resulting 

target parameters are e.g. the solid to volume percentage or the density of the final 

material. By varying the initial parameters, new model materials can be created, and 
their properties can be optimized. Optionally, a result file (*.gdr) from GrainFind-

Identify Grains can be loaded (see the GrainFind handbook of this User Guide) to set 

the initial parameters. 

The structures can be further processed by a simulated sintering process, growing 

sediments, redistribution of the grains or by adding binder. Examples for possible 

structures are shown in the figure below.  

 

With other GeoDict modules, the structures can be further analyzed and processed: 

Geometric properties like pore-size distribution (PoroDict) and transport properties 

like tortuosity, effective diffusion, and effective electrical and thermal conductivity 
(ConductoDict, DiffuDict) can be calculated. Flow resistivity (permeability, pressure 

drop), filter efficiency, filter capacity, and many more, can be computed using e.g. 

FlowDict, FilterDict and AddiDict. Mechanical large deformation and stress/strain 

curves can be simulated using ElastoDict and the charging of battery electrodes can 

be analyzed with BatteryDict  

The generated models are available as 3D images and can be exported for further 

processing using additional software. Using ExportGeo-CAD, the structures can be 

meshed and exported as well. 

Distribute, Sinter, Roughen, Add Binder, … 

Structure Size, Grain Shape, SVP, Density, … 

Create Grains, Pile Grains, Pack Analytic Spheres 

1. Define and vary initial and target parameters 

2. Create granular microstructures  

3. Postprocessing 

For more complex examples, see the Grain GeoApps (page 138) 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GrainFind&release=2023&heading=IdentifyGrains&heading=LoadGrainFindResults
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GRAINGEO SECTION 

To open the GrainGeo module, select Model → GrainGeo in the GeoDict menu bar. 

In the GrainGeo section, a pull-down menu lists all available GrainGeo commands. 

 

 

 

◼ Create Grains generates granular structures with user-defined parameters. 

◼ Pile Grains simulates grains falling, rotating and finally settling to create the 

structure. Arbitrary objects can be chosen as grains. 

◼ Pack Analytic Spheres creates dense sphere packings close to the maximal 

possible packing density given a fixed number of spheres and a user defined 

distribution of sphere sizes. 

◼ Pile Analytic Spheres is faster and might lead to denser packings than Pile 

Grains, but it is limited to spheres. 

◼ Stochastic Field Thresholding creates a structure by segmenting a user-defined 

stochastic field following selected threshold criterions. 

◼ With Distribute, grains can be redistributed in the domain to create a more 

homogeneous material. 

◼ Sinter & Crystallization simulates a sintering process by compressing the 
structure currently in memory. The packing density is maximized, and grain 

boundaries can be formed. 

◼ With Grow Sediment, new material is applied to the existing objects. 

◼ Through Roughen Surface, the surfaces of objects in the granular structure are 

roughened with small grains. 

◼ Add Binder adds material in the shape of a concave meniscus in locations where 
objects in the structure are close together. The addition of binder in granular 

structures can be modeled this way. 

◼ Grain GeoApps creates predefined materials from different application areas.  

After selecting a command from the pull-down menu, the necessary parameters can 

be entered through the corresponding Options’ Edit … button located in its panel.  
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After setting the input parameters for the selected GrainGeo generation, clicking 

Generate in the GrainGeo section starts the generation. The granular structure is 

created and shown in the Visualization area.  

Macro files are recorded and saved when selecting Macro → Start Macro 

Recording... in the menu bar. When recording a macro, Record becomes active and 

Generate changes to Generate & Record. 

Click Run in Cloud to run it in the GeoDict cloud, see the High Performance 

Computing chapter of the GeoDict User Guide for details. If interested in cloud 

simulations contact Math2Market to apply for a GeoDict cloud license.  

The commands Create Grains, Pile Grains, Pack Analytic Spheres, Pile Analytic 

Spheres, Stochastic Field Thresholding and Grain GeoApps generate a new 

structure model or a new structure model in the domain or on the objects / structure 
currently in memory. All other processes require a valid initial structure already in 

memory. 

 

 

If you save the parameters of the Options dialog into GPS (GeoDict Project 

Settings) files, you can reload them at will.  

Remember to restore and reset your (or GeoDict’s) default values through the 

icons at the bottom of the dialog when needed and/or before every GrainGeo 

run. Resting the mouse pointer over an icon prompts a Tooltip showing the 

icon’s function to appear.  

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=HighPerformComp&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=HighPerformComp&release=2023
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CREATE GRAINS 

When choosing Create Grains from the pull-down menu, granular structures can be 

generated, either in an empty domain or on already existing structures. Clicking the 
Options’ Edit… button in the GrainGeo section opens the GrainGeo Create 

Options dialog.  

At the top left of the GrainGeo Create 

Options dialog, the name for the file 

containing the generation results can be 
entered in the Result File Name (*.gdr) box. 

The default name can be kept, or a new name 

can be chosen, fitting the current project. 

The available units (m, mm, µm, nm and 

Voxel) are selectable from the pull-down menu 
at the top right of the GrainGeo Create 

Options dialog. When the units are changed, 

the entered values are adjusted automatically.  

The GrainGeo Create Options dialog is organized using four tabs:  

◼ Create Options: Determine general properties of the resulting structure, such 

as size, position, resolution, and solid volume fraction.  

◼ Object Options: Define the geometrical properties of individual object types 

such as cross-section, length, and orientation. Up to eight different object types 

can be used in one structure. 

◼ Object Overlap: Defines how the IDs of different materials and objects are 

assigned. This is relevant for overlap operations performed on the structure 

and to define different materials with respective properties in the structure.  

◼ Result Options: Determine if and how the resulting geometry is saved. 
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The result files are saved in the chosen project folder (File → Choose Project 

Folder, in the Menu bar). If a GeoDict results file (*.gdr) with the given name already 

exists in the project folder, a warning message is shown at the start of the creation 

process. The user can either decide to back up the old file, to overwrite it, or to cancel 

and choose a new file name. 

CREATE OPTIONS 

The geometric properties of the desired granular structure are accessible under the 

Create Options tab. The parameters there are grouped under the panels Domain, 

Generation and Overlap Mode, and Stopping Criterion. 

CREATE IN CURRENT DOMAIN AND KEEP CURRENT OBJECTS / STRUCTURE 

When checking Create in Current Domain, the structure currently in memory, is 

considered during the generation of a new structure. Additionally, when Keep 

Current Objects / Structure is checked, the structure in memory is kept and 

combined with the newly generated granular structure. 

This feature is used in combination with checking Prohibit Object Overlap or 

Prohibit Overlap with Current Objects (see below, pages 12ff.) in the Generation 

and Overlap Mode panel. By this, complex models of granular structures can be 

generated. For example, the user can make copper spheres cover a mold that is later 
discarded.  

Once Create in Current Domain is checked, the parameters grouped under the 

Domain panel are inactive, including the voxel length, because they are taken from 

the structure already in memory. 

In the example below, a previously generated mold (current object / structure) is 

present in memory while spheres are added. Prohibit Overlap with Current 

Structure is checked to avoid the spheres from entering the mold, but the spheres 
can overlap each other. The spheres are automatically assigned as material ID 02, 

while keeping the initial structure (with Material ID 01). 
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If the spheres should not overlap each other, nor the mold, either Prohibit Object 
Overlap or Without (Remove) Object Overlap should be checked. In general, 

both options avoid overlap between newly created objects, as well as between newly 

created and already existing objects. But while Prohibit Object Overlap recreates 

each object until the overlap is removed, Without (Remove) Object Overlap 

creates all objects at once and then shifts them until the overlap is removed 
Nevertheless, with Without (Remove) Object Overlap, a residual overlap might be 

left. In most cases, the latter is faster and achieves a higher packing density and 

should therefore preferably be used.  

DOMAIN 

The Domain panel contains the parameters defining the structure size (NX, NY, and 

NZ) in combination with the resolution (Voxel Length), as well as the Origin 

parameters, the Periodicity checkboxes, the Center Domain button, and the Pore/ 

Matrix Material button. 

 

 

NX, NY, NZ, and Voxel Length  

The internal representation of a structure in GeoDict consists of rectangular 3D arrays 

of equally sized boxes, hereafter called volume elements or voxels.  

NX, NY, and NZ are the number (N) of voxels in X, Y and Z directions.  
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The Voxel Length is the size of one voxel in the chosen units. Varying the values for 

NX, NY, and NZ has the effect of changing the size of the structure in the given 

direction. 

 

 

 

 

 

 

 

 

 

 

 

 

Low values for Voxel Length in combination with high values for NX, NY and NZ 

increase the resolution, but also increase computational time. After setting the values 

of NX, NY, and NZ, and Voxel Length, the physical structure size is automatically 

displayed in the chosen units (here µm). 

The following example shows how starting with NX = 200, NY = 200, NZ = 200 

(100 x 100 x 100 µm3, at voxel length 0.5 µm), and decreasing the Voxel Length 

from 0.5 µm to 0.25 µm has the effect of refining the structure by increasing the 

resolution, while decreasing the size of the volume to 50 x 50 x 50 µm3.  
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By setting NX = 400, NY = 400, NZ = 400, to restore the size of the volume to the 

original 100 x 100 x 100 µm3, the structure is displayed at higher resolution. 

 

Origin X, Origin Y, and Origin Z, and Center Domain 

The Origin X, Origin Y, and Origin Z parameters, together with the Center Domain 

button, determine the placement of the structure in the physical space. Zero values 

for Origin X, Origin Y, and Origin Z mean that the point with (0, 0, 0) coordinates is 

located at the lower left corner of the structure. 

Entering values for Origin X, Origin 

Y, and Origin Z differing from (0, 0, 
0) is useful in applications that 

require exact structure coordinates. 

 

 

 

 

 

 

 

 

When clicking the Center Domain 

button, the (0, 0, 0)-point is set to 

the center of the structure.  

 

 

 

Periodicity 

Checking the Periodic X, Periodic Y, and Periodic Z boxes allows the generation of 
structures which are periodic in one or several directions. Periodicity has the effect, 

that objects ending on one side of the volume reappear on the opposite side, so that 

merging of several volumes with periodic objects results in a repetitive complex.  

X 

Y 

Z 

(0,0,0) 

(Origin X, Origin Y, Origin Z) 

(Origin X, Origin Y, Origin Z) 

X 

Y Z 

(0,0,0) 
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Checking the Periodic X and Periodic Y boxes, but leaving un-checked the Periodic 

Z box, has the following effect on the periodicity of a generated granular structure. 

 

This effect can be observed more closely, when processing the sample structure 

through Model → ProcessGeo (Repeat: X- 400 voxels, Y- 400 voxels, and Z- 400 

voxels) and viewing it again from the three directions.  

 

View → 3D Rendering 

View → 2D Cross Section 
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In the directions checked as periodic (X and Y), the short circular fibers and ellipsoids 

connect to each other across the repeated samples. In the direction checked as non-

periodic (Z), the objects end at the edge of the sample. 

 

 

 

 

The structure shows periodicity in X- and the 

Y-direction, with unit cells passing 

continuously into each other in both directions. 

  

The structure shows periodicity in X-direction, 

with unit cells passing smoothly into each 

other, and no periodicity in Z-direction, with 

unit cells appearing disconnected. 

  

The structure shows periodicity in Y-
direction, with unit cells passing smoothly 

into each other, and no periodicity in Z-

direction, with unit cells appearing 

disconnected. 
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Pore / Matrix Material (ID 00) 

When the matrix material with ID 00 is chosen to be Pore, the objects are embedded 

in empty pore space. Alternatively, the material filling the pore space can be a Solid, 

a Porous medium, or Fluid, in which the structural objects are embedded. The 

physical properties of the pore material can be attributed for simulations. The color 

and the visibility/invisibility can be chosen independently of the material. 
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GENERATION AND OVERLAP MODE 

The options in the Generation and Overlap Mode panel control the relative position 

among objects or of the structure currently in memory. It is possible to choose Allow 
Object Overlap, Remove (Without) Object Overlap, Prohibit Object Overlap, 

Use Isolation Distance, Match Solid Volume Fraction Distribution, Enforce 

Object Overlap.  

Allow Object Overlap 

Objects may overlap when selected.  

 

Without (Remove) Object Overlap  

Checking Without (Remove) Fiber Overlap eliminates existing overlaps after the 

generation step. The user should consider that: 

◼ Overlaps can be removed from: 

◼ Periodic structure models with objects smaller than the domain size. If objects 

longer than the domain size are present in the model, they might overlap with 

themselves. This type of overlap will not be removed. 

◼ Non-periodic structure models with arbitrary object sizes. 

◼ The statistical properties might change slightly after removing overlap. 

◼ The way in which the overlap removal occurs can be controlled through the 

Remove Overlap Options accessible via the Edit … button.  

In the Remove Overlap Options dialog, the following parameters can be set: 

◼ Iterations: Defines after how many iterations the removal stops. 

◼ Iterations SVP Unchanged: The removal stops if the SVP (Solid Volume 

Percentage. See page 23) remained unchanged during this number of iterations. 

◼ Overlap SVP / (%): Defines the final allowed Overlap SVP. 

◼ Allow Object Shifts: Check if shifting the objects should be an allowed operation 

for overlap removal. Define the Number of Shifts per iteration and the maximal 

Shift Distance per iteration.  

◼ Allow Object Rotations: Check if rotating the objects should be an allowed 
operation for removal. Define the maximal Number of Rotations allowed per 

iteration. Objects will be rotated in all directions, where the maximal rotation angle 

per iteration is one degree. 
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◼ Allow Fiber Deformations: Check if bending fibers should be an allowed 

operation for overlap removal.  

 

 

 

 

 

 

 

 

 

Define the Maximal Bending Angle allowed between two segments. Each fiber 

consists of several segments. The center points of the segment connections are 
shifted in all directions, while the other shape parameters, as e.g. fiber length and 

segment length are kept constant. The maximal point shift distance is the same as 

for the object shift. This option is only applied to fibers, as other objects do not 

consist of segments.  

◼ Distance Mode: The pull-down menu offers four options: 

◼ The objects can be Touching (distance zero).  

◼ Enter a maximal Defined Overlap allowed for the objects.  

◼ Enter a minimal Defined Isolation distance for the objects. 

◼ Avoid Contacts means a defined isolation of one voxel volume diagonal  

Note: While Touching works for all object types, the other three options cannot 

handle the object types Combined Object, Intersected Object and Triangle. 

In a periodic domain, objects which are longer than the domain might overlap with 

themselves. This type of overlap cannot be removed. In this case, a message appears:  
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Prohibit Object Overlap  

 

Objects may touch but not overlap when selected. In this case, the overlap of the 

objects is prohibited during the creation process. This option might lead to longer run 

times compared to Remove Objects Overlap. It only works for low volume 

percentages.  

As mentioned above, objects longer than the domain might overlap themselves if a 

periodic domain is selected. 

Use Isolation Distance 

 

Inserting a positive value, the gaps between objects have at least this preset distance. 
When set to negative values (e.g. -40 µm), the effect is that the objects may overlap 

maximally by 40 µm (showing in a different color, here blue). While the distance mode 

Defined Isolation in Remove Overlap considers the objects, the Use Isolation 

Distance option only considers the voxel structure, and thus works for all object 

types.  

Negative values for the isolation distance are useful to model synthetic objects that 

melt, or objects that deform at their touching points.  
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Prohibit Overlap with Current Structure 

If checking Create in Current Domain (see page 5), Prohibit Overlap with 

Current Structure appears instead of Match SVF Distribution. The objects in the 

newly generated structure can intersect with each other but not with those of the 

already existing structure.  

Observe this effect in a structure with one (red) ellipsoid over which a new structure 

with blue and gray spheres is generated.  

 

 

 

Whereas the blue and gray spheres overlap 
with each other, they do not overlap with 

the red ellipsoid. 

 

 

 

 

 

 

 

 

 

 

  

To create a structure with a high packing density and a defined isolation 

distance or overlap between the grains, use Without (Remove) Object 

Overlap with the respective Distance Mode, since the object shifts, rotations 

and deformations will ensure the packing density. With Use Isolation 
Distance as Overlap Mode, high packing densities cannot be achieved. In 

this case, the algorithm will not shift, rotate or deform the objects, but only 

generate the structure randomly until the isolation distance matches or the 

maximal runtime is reached. 
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Match Solid Volume Fraction Distribution 

For certain applications it is necessary to create statistical distributed 

inhomogeneities, e.g. to generate a bimodal distribution of grains. The Match Solid 
Volume Fraction (SVF) Distribution command allows to create such structures 

with an inhomogeneous solid volume distribution. Grains are shifted and rotated to 

optimally match a SVF distribution given by a Gaussian random field. This takes place 

after the generation step. The user should consider that: 

 

 

 

 

 

 

 

 

 

 

 

◼ Periodicity is checked automatically for all directions. This is a prerequisite for the 

Match Solid Volume Fraction algorithm. 

◼ Using this feature, overlap cannot be removed during structure generation.  

◼ As the SVF distribution is matched after generating the grains fitting the Stopping 

Criterion (see page 93), the resulting values can differ from the inserted 

parameters for the Stopping Criterion. This is because the structure is generated 

with overlap and the amount of overlap can change when grains are shifted. 

◼ The distribution for Center defined in the Object Options tab will also be affected 

strongly by matching the SVF distribution after generating the grain structure with 

the specified center distribution. The difference between the Center Distribution 

and the Match SVF Distribution is explained on page 20. 

◼ It is recommended to generate the structure without inlet and outlet to use this 

algorithm. Otherwise, the objects will be also moved to these empty spaces. If 

desired, add inlet and outlet either with GadGeo - Edit Domain to avoid cropped 

objects or with ProcessGeo -Embed as described in the corresponding handbooks 

of the User Guide. 

◼ It is possible to reuse an existing stochastic field describing the desired SVF 

distribution. For this, first generate the structure with the mode Allow Overlap 

and then use the corresponding algorithm in GadGeo. Open the GadGeo section 

by selecting Model → GadGeo from the menu bar. Select Algorithms from the 

first pull-down menu and then Match SVF Distribution from the second. How to 

use this algorithm is described in the GadGeo handbook of the User Guide. 

◼ For large structures, the feature needs a large amount of memory as a volume 

field is loaded in GeoDict additional to the structure file. 

 

The SVF distribution can be controlled through the Match SVF Distribution dialog 

accessible via the Edit … button.  

https://geodict.com/fileadmin/script/UserGuide.php?lang=en
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GadGeo&release=2023&heading=MatchSVFDistribution
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In the Match SVF Distribution dialog, the following parameters can be set: 

◼ Stopping Criterion: Define the Error Bound to determine when the SVF 
matching should be stopped. When the normalized relative change of solid volume 

fraction is smaller than the given error bound, the algorithm is stopped.  

◼ Distribution Coarsening Factor: The SVF distribution is matched using a coarser 

version of the created Gaussian random field. The value must be small enough to 

resolve the heterogeneity of the structure. A larger value leads to a shorter run-

time. 

If the Distribution Coarsening Factor is set to 1, the Gaussian random field is 

generated with the same resolution as the grain structure.  

For a grain structure with a domain size of 2048x1024x512 voxels and a voxel 

length of 1µm a coarsening factor of 32 leads to a random field of 64x32x16 voxels 

with a voxel length of 32µm.  

To resolve the correlation length with a whole number of voxels, the value should 

be chosen as a divisor of the correlation length, which in turn is recommended to 

be a divisor of the domain size. For example, if the correlation length is set to 128 

voxels and the coarsening factor is set to 32, 128/32 = 4 voxels remain to resolve 

one feature of the random field. 

◼ Distribution Mode: For distribution select Gauss or Gradient from the pull-down 

menu. The following parameters are different for these two options. It is 

recommended to select a divisor of the domain size in the corresponding direction. 

For a constant SVF in one direction choose the corresponding domain size as 

correlation length. 

 

Gauss: 

◼ Correlation Length: The correlation length is a measure for the inhomogeneity 

of the material. The parameters for X-, Y- and Z-Direction determine the 

correlation length of the Gaussian random field, which defines the SVF 

distribution. 

◼ Distribution Standard Deviation: Define the relative standard deviation of 

the created SVF distribution. A larger value leads to a larger difference between 

the regions of low and high density. 

 

Gradient: 

◼ Use Relative Position: If checked, the left gradient column values from 0 to 

1 correspond to locations in the structure.  

In the Z-direction, the value 0 is at the 

origin and the value 1 is at end of the 

domain. If not checked the values in the 
left column correspond to absolute values 

in the given unit. 
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◼ Distribution Gradient: The right column assigns relative density values at 

the locations defined in the left column, e.g. the value 10 means that there are 
five times more objects at Z = 1 than at Z = 0.1, with a density value of 2. The 

object density increases and decreases smoothly between the given locations 

in the Z-direction.  

◼ Number of Rows: The number of rows in the Distribution Gradient can be 

increased or decreased to enter as many pairs of position and density as 

desired. 

◼ Load/Save: The Distribution Gradient can be saved to and loaded from a .txt 

file.  

 

In the following example, grains are generated in a domain of 600x600x50 µm.  

For the first structure Allow Object Overlap is checked and no SVF distribution is 

matched.  

The structure of the second picture was generated with the same parameters except 

for matching the SVF distribution shown below. 

 

 

After generating a structure matching a SVF distribution in the result folder a volume 

field describing the used gaussian random field is saved.  

Select File → Load Volume Field … from the menu bar to load it or choose the Data 

Visualization tab in the Result Viewer of the (*.gdr) result file and click Load 

*.gvf.  
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For the example from above, the resulting gaussian random field is shown below in 

2D view from all three directions. 

Viewed from X-direction a high correlation in Z-direction can be observed, as the 

structure size in this direction equals the Correlation Length Z. In Y-direction a 

more inhomogeneous SVF distribution was generated, as the structure size in Y-

direction is 12 times higher than the Correlation Length Y. 

 

 

 

 

 

 

 

Viewed from Y-direction a similar observation can be obtained. Still the distribution in 

Z-direction is very homogeneous, whereas it has low correlation in X-direction. 

 

 

 

 

 

 

 

Viewed from Z-direction the structure is very inhomogeneous, due to small 
Correlation Length values for X and Y (50µm) compared to the structure size in 

these directions (600µm).  

 

 

 

 

 

 

 

 

 

 

 

 

Z 

Y 

Z 

X 

Y 

X 
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In the following example observe how the objects are distributed corresponding to 

the given Gradient.  

The objects in the first example have the highest density in the center of the Z-axis. 

Towards both ends of the domain in Z-direction the objects become fewer. This 

displays the Density values 0 for the relative positions Z=0 and Z=1 and a density of 

1 for the relative position Z=0.5.  

 

 

The second example shows a density distribution in Z-direction with 4 rows . A density 

of 20 for position Z=0 leads to twice as many objects near the top as objects in the 

lower third with a density value of 10 for position Z=0.7. Towards the center and the 

bottom, the objects become fewer for a density value of 0. 

 

 

This feature is different from the Density Distribution for Center, to be found in 

the Object Options (see page 26). The Match SVF Distribution is a post-processing 

step, and the grains are moved till they match the given solid volume fraction 

distribution.  
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For the Center Distribution, the object centers are placed according the given 

distribution which is much faster and does not change the orientation of the objects, 
but leads to a different solid volume fraction distribution and the distribution is not as 

smooth as with Match SVF Distribution. 

 

  

Center Distribution SVF Distribution 



Generate and model granular structures with GrainGeo 

22  GeoDict 2023 User Guide 

Enforce Object Overlap 

The structures objects are required to join each other, forming a large, connected 

component. This effect is obvious when the structures solid volume percentage is low 

(here 10%), i.e. the objects do not already form a connected component.  

 

STOPPING CRITERION 

The parameters in the Stopping Criterion panel of the GrainGeo Create Options 

dialog define the stop criterions. The available parameters are Fixed Object 
Number, Solid Volume Percentage (%), Grammage (g/m2), Density (g/cm3) 

or Object Weight Percentage (%). Additionally, when the Maximal Run Time 

(h) is expired, the process is stopped even when the desired stopping criterion cannot 

be achieved.  

 

 

 

 

 

 

 

 

When Grammage, Density or Object Weight Percentage are chosen as stopping 

criterion, the temperature must be set as additional parameter. The density of the 

constituent materials will be set with respect to the chosen temperature based on the 

Material Database  
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When choosing Fixed Object Number or Solid Volume Percentage, the 

Temperature parameter is not available. 

Fixed Object Number 

When Fixed Object Number is chosen as stopping criterion, GrainGeo places the 

given number of objects in the structure and then the generation stops.  

Observe the effect of setting a fixed number of objects (10, 100, or 200) as stopping 

criterion, for the generation of a structure with two types of spheres. All other 

parameters are left untouched. 

 

Object Solid Volume Percentage 

Object Solid Volume Percentage (SVP) determines the fraction of the total volume 
in percent that the structure should have. Accepted values range from 0 to 100%. 

For example, a structure with an Object Solid Volume Percentage of 40 consists 

of 40% spheres and 60% void space. Porosity is defined as (1 – SVP/100). Observe 

the difference in a structure when varying the solid volume percentage from 5%, to 

20% and finally to 40%, while all other parameters are left unchanged. 

 

Grammage 

The Grammage (g/m2) determines the mass per unit area (in the XY-Plane) of the 
resulting structure. When Grammage is chosen as stopping criterion, the Density 

(g/cm3) of the object material(s) must be defined for each object type and chosen 

material in the object panels under the Object options tab and the temperature 

must be set in the GrainGeo Create Options dialog.  
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Observe the effect of increasing the Grammage from 60 g/m2 to 120 g/m2, whereas 

all other parameters are left unchanged. 

 

Density 

The Density (g/cm3) of the resulting structure depends on the densities of the 
constituent materials. In the following simple example, the Matrix Density is 0 (for 

vacuum), and the two grain types have the densities 3.1 g/cm3 and 1.0 g/cm3. The 

Density of the structure is set to 0.10 g/cm3 and to 0.25 g/cm3. It cannot be set 

smaller than the lowest occurring density (here 0 g/cm3) or larger than the highest 

occurring density (here 3.1 g/gm3). 

 

Object Weight Percentage 

The Object Weight Percentage determines the weight of the created object in 

relation to the weight of the whole structure (including the pore material). The 

calculation is only possible when the density of the Pore / Matrix Material is greater 

than zero. Otherwise, an error message will appear. 
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The relationship of the values Fixed Object Number, Object Solid Volume 

Percentage, Grammage, and Density can be observed in the Result Viewer under 
the Results tab. If the density of the Pore / Matrix Material is greater than zero, also 

the Object Weight Percentage appears under the Results tab. 

In this example, a Density of about 0.10 g/cm3 corresponds to a Fixed Object 

Number of 219, a SVP of 3.88% and a Grammage of 20.04%. 

 

Maximal Run Time 

The Maximal Run Time (h) becomes important when generating complex structures 

with elevated solid volume fraction. When Prohibit Objects Overlap has been 

checked, the required number of objects in the structure may become unattainable. 
In that case, the structure generation is stopped after the time entered in Maximal 

Run Time has passed and the achieved structure is considered as the result. The 

analysis of the GDR result file shows any disparity between the achieved result values 

and the desired ones. 

RANDOM SEED 

Random Seed initializes the random number generator behind the structure 
generator. Changing its value produces different sequences of random numbers and 

hence, different realizations of the specified structure. If all settings are equal, 

generating with the same Random Seed value produces the identical structure. 

Random Seed must be a non-negative integer number.  

Varying the Random Seed allows generating different samples of the same granular 
structure. In the following examples, all parameters are unchanged while the Random 

Seed automatically increases with every generation run (54, 55, 56). 
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OBJECT OPTIONS 

The objects available for the generation are organized and listed in panels. Up to eight 

different object types may be added to the same structure. 

For all objects, the left column of the panel contains the Object Type name, the 

object percentage in the structure as Count, Volume, or Weight, and the object 

Material. 

The middle column shows a drawing of the main geometrical characteristics of this 
object type. In the right column, the geometrical properties or defining parameters 

of the objects can be entered. These geometrical parameters include Diameter, 

Orientation, Length, Position, Enclosing Object, Number of Points, etc. 

 

Sphere and Ellipsoid are the default Object Types. At the bottom left of the dialog, 
clicking Add inserts other object types chosen from the Object Type pull-down 

menu. Previously saved objects with individually defined parameters can be loaded 

via the Load… button. Object types can be discarded again when clicking Remove 

in the left panel or can be saved as predefined object using the Save… button. 

Clicking on the object type name minimizes the object panel, and clicking on it again 
when minimized, expands it again. A scroll bar at the right allows to navigate up and 

down in the list of chosen object types. 
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OBJECT TYPE PERCENTAGE AS COUNT, VOLUME, OR WEIGHT 

The object type percentage can be specified as Count %, Volume % and Weight % 

as selected from the pull-down menu at the bottom right of the dialog.  

 

Note that, if the Weight option is chosen, the material density must be provided (or 

it is taken from the GeoDict material database) even when Grammage is not selected 

under the Create Options tab.  

 

MATERIAL 

Material designates the constituent material assigned to the object type used in the 

granular structure. The pull-down menu gives access to selecting the desired material 

from the GeoDict Material Database. When none of the materials available in the 
database fit the preferred specifications, Manual should be chosen. Alternatively, a 

new material with the desired specifications can be added to the Material Database 

(see the Material Database handbook of this User Guide)  

 

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MaterialDatabase&release=2023


Generate and model granular structures with GrainGeo 

28  GeoDict 2023 User Guide 

To match realistic material colors for visualization in a certain application, the default 
Material colors can be changed through Settings → Color & Visibility Settings in 

the Menu bar. For more visualization options, see the Visualization handbook of this 

User Guide. 

OBJECT TYPES 

The Object Type is selected from the pull-down menu or can be loaded via the 

Load… button at the lower left of the Object Options tab in the GrainGeo Create 

Options dialog. 

 

 

 

The following table summarizes the object types that can be used with GrainGeo 

Create and Pile commands: Sphere, Hollow Sphere, Ellipsoid, Superquadric 
Particle, Box, Planar Polyhedron, Convex Polyhedron, Pyramid, Short Fibers 

(Circular, Hollow, Rosetta, Elliptical, Cellulose, Rectangular, and Angular), 

and their combinations (Combined Objects). 

 

 

Defining parameters Object type and examples 

 
 

 

 

Sphere 

Hollow Sphere 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Visualization&release=2023
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Ellipsoid 

Box 

Planar Polyhedron 

Superquadric particle 
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Convex Polyhedron 

Enclosing Object: 

Sphere 

 

Convex Polyhedron 

Enclosing Object: 

Ellipsoid 

Convex Polyhedron 

Enclosing Object: 

Box 

 

Convex Polyhedron 

Enclosing Object: 

Pyramid 

Pyramid 
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Short Circular Fiber 

Short Hollow Fiber 

Short Rosetta Fiber 

Short Elliptical Fiber 

Short Cellulose Fiber 
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OBJECT PARAMETERS 

The right column of the Object Type panel contains the parameters controlling the 

geometrical and physical properties of each object type of the granular structure.  

Some object parameters can only be set for specific object types, e.g. Number of 

Edges, and Ray Length are only applicable for planar polyhedrons. Other 

parameters are common to several objects, such as e.g. Diameter, Center, Length, 

or Orientation. 

 

The defining parameters can be edited in the dialogs which open when clicking the 

corresponding Edit … buttons. 

Short Rectangular Fiber 

Short Angular Fiber: 

Red: 3 edges 

Gray: 5 edges 

Combined Object 
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The Diameter and the Enclosing Object Diameter, but also the Ray Length, the 

Side Length, the Wall Thickness, the Height, and the Scaling Factor (for 
Combined Objects) can be set to a Constant value, or to follow a distribution 

(Uniformly in interval, Gaussian, Probability Distribution (user-defined), or 

Log-Normal).  

 

 

 

 

 

 

 

 

 

 

 

 

The Number of Edges (for Planar Polyhedrons) and the Number of Random Points 
(for Convex Polyhedrons) values also set to be Constant, to distribute Uniformly in 

interval, or to follow a Gaussian or user-defined Probability Distribution.  

 

 

Finally, the Center value can be set to distribute Uniformly, On Current Objects, 

Uniformly in Box, or follow a user-defined Density Distribution. These 

distributions are explained in detail below (see pages 58ff., Object Parameters → 

Center). 

The option to center On Current Objects is only 

present when the user has checked Create in 

Current Domain (see page 5).  
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Diameter 

Observe the effect that the Diameter options (as shown in the dialogs) have on the 

generated granular structure made of spheres. 

 

 

 

 

 

 

 

 

 

 

Uniformly in Interval 

When selecting Uniformly in interval, and entering a Minimum value and a 
Maximum value, the range of the respective parameter is uniformly distributed 

within the given interval. 

 

 

 

 

 

 

 

 

 

 

Gaussian 

Taking the Gaussian (or normal) distribution, the random diameter, enclosing object 
diameter, ray length, side length, thickness, height, or scaling factor values follow a 

bell-shaped distribution. The diameter and length values cluster around the entered 

Mean Value but may vary according to the entered Standard Deviation. 

The value in Distribution Bound corresponds to the interval on both sides of the 

mean value limiting the random diameter or angle values that are accepted. For 

diameters, a Distribution Bound value of 10 µm means that the diameter values 
may vary only -10 µm to +10 µm from the given Mean Value. The parameters must 

be set so that no negative values are possible. For example, a diameter mean value 

of 20 µm and a distribution bound of 25 µm would lead to an error message appearing, 

as the diameter could reach a value less than zero. 
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For all distribution options (Gaussian, Probability Distribution and Log-Normal) on the 

right of the dialog the distribution is visualized in a 2D plot.  

 

 

 

 

 

 

 

The red line plots the Diameter Percentage Distribution defined by Mean Value, 

Standard Deviation and Distribution Width. It displays how much objects of which 

diameter will be generated in percent.  

The blue curve visualizes the cumulative diameter distribution.  

The three dashed blue lines show the diameter values for the 10% percentile, the 
50% percentile and the 90% percentile of the distribution. On average, 10% of the 

objects have a diameter smaller than the 10% percentile value, and 90% of the 

generated objects have a diameter higher than that value. For further explanations, 

see the Wikipedia article. 

Right-clicking to the plot opens a dialog to save 
the plot or to Edit the Axis Settings. Checking or 

unchecking the checkboxes next to the graph 

names decides which curves should be displayed. 

More information about these options can be 

found in the Result Viewer handbook of this User 

Guide. 

 

 

20 

µm 

30 

µm 

      10 

µm 

10 10 

https://en.wikipedia.org/wiki/Percentile
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ResultViewer&release=2023
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If Cut-Off Distribution is checked, the distribution is truncated at the bounds. This 

means that all values outside the bounds are dropped and not considered for 
generation. If this option is not checked, then all values that are outside of the bounds 

are set to be on the distribution bound. Not checking this option leads to an 

accumulation of values on the bounds. 

In the example below, leaving Cut-Off Distribution unchecked leads to many grains 

with diameters of 40 and 60 µm.  

In contrast, checking Cut-Off Distribution leads to more grains with diameter 

between 40 and 60 µm. 

More details on Gaussian distributions can be found e.g. on the Wikipedia page on 

Normal (or Gaussian) distributions.  

 

http://en.wikipedia.org/wiki/Normal_distribution
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Probability Distribution 

The Probability Distribution table allows entering user-defined probability 

distributions. The Number of Rows can be increased or decreased to enter as many 

diameter (or other) Values and their Count Probability, between 0 and 1.  

In our example, 50% of spheres have a diameter of 20 µm, 20% a diameter of 35 

µm, and 30% a diameter of 5 µm. 

 

For large tables, it is useful to observe the value of Probability Sum, i.e. the sum of 

the count probabilities. When the Probability Sum is not equal to 1, click the 
Normalize button to automatically scale the Count Probability values. The buttons 

Load… and Save… allow loading a previous probability distribution and saving the 

current for later use. 

Log-Normal 

The Log-Normal distribution describes the situation in which the logarithm of the 

values follows a normal distribution. Further details on the logarithmic normal 

distribution can be found on the corresponding Wikipedia page. 

http://en.wikipedia.org/wiki/Log-normal_distribution
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The values group around the entered Arithmetic Mean Value (E[x]) and scatter 

according to the entered Arithmetic Standard Deviation (SD[x]) of the log-
normally distributed variable x. The values in Lower Bound and Upper Bound 

restrict the possible values to the given interval. 

The diameters are distributed according to the log-normal distribution with mean 

value of 15 µm. All diameters must lie between 5 µm (lower bound) and 30 µm (upper 

bound). 

Diameter, Inner Diameter Fraction, Aspect Ratio, Wall Thickness, Amplitude Fraction 

The Diameter value can be edited by clicking Edit... to open the Diameter dialog. 

The diameter can be set to a Constant value, or to follow a diameter distribution 
(Uniformly in interval, Gaussian, Probability Distribution, or Logarithmic-

Normal (Log-Normal)) as indicated above in pages 32ff. 

Spheres or short fibers, as well as pyramids are defined by one diameter value. For 

the objects among them, which have a second diameter, the Aspect Ratio or the 

Wall Thickness value determine the other diameter value. Ellipsoids, 
Superquadric Particles and Boxes are defined by three diameters (Diameter 1, 

Diameter 2, and Diameter 3) which control the shape and size of the object.  

 

For non-circular fibers, the diameter but also other parameters control their shape. 

For a hollow fiber, the Inner Diameter Fraction defines the ratio of the entered 

(outer) diameter to the inner diameter.  

 

For short elliptical fibers, defined by two diameters, the Aspect Ratio is the 

relationship between the longer diameter Diameter 1 and the shorter diameter 

Diameter 2. 
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For fibers with Rosetta cross-section, the Amplitude Fraction determines the length 

of the Rosetta leaves, whereas the Number of Leaves defines how many leaves the 

Rosetta has. 

 

For a Convex Polyhedron, the shape determining parameters depends on the chosen 

Enclosing Object. For a Sphere, Ellipsoid or Pyramid as Enclosing Object, the 

respective diameters must be set as described above.  

Length, Side Length and Ray Length 

The three values of Length for boxes and the Length for all short fibers, the Side 

Length of short rectangular fibers, as well as the Ray Length of planar polyhedrons 

are editable by clicking Edit... and choosing the desired settings in the Length dialog. 

The Length, Side Length, and Ray Length can be set to take a Constant value, or 

to follow a distribution (Uniformly in interval, Gaussian, Probability 

Distribution, or Logarithmic-Normal).  

Boxes are defined by Length 1, Length 2, and Length 3 which control the shape 

and size of the object. 
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For short rectangular fibers, the Side Length 1 and the Aspect Ratio can be entered. 

The relationship between these parameters is like that between Diameter 1 and 

Aspect Ratio for short elliptical cross-sectioned fibers explained above. 

 

For planar polyhedrons, the Ray Length is the distance from the center of the object 

to any of the edges.  

 

 

 

 

 

 

 

 

 

When choosing a Box as Enclosing Object for a Convex Polyhedron, the Lengths 

have to be defined according to the Box object. 

Blockiness 

For Superquadric Particles the parameters Blockiness 1 and Blockiness 2 control 

the shape of the object. The entered values must be positive, otherwise an error 

message appears, when clicking Generate. 
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The surface of a Superquadric Particle is implicitly defined by the formula: 

(|
𝑥

𝑑1
|

𝑏2

+  |
𝑦

𝑑2
|

𝑏2

)

𝑏1
𝑏2

+ |
𝑧

𝑑3
|

𝑏1

= 1  

The three Diameter values correspond to the diameters 𝑑1, 𝑑2, 𝑑3 in the formula, 

Blockiness 1 to the exponent 𝑏1 and Blockiness 2 to the exponent 𝑏2.  

For exponents 𝑏1 = 𝑏2 = 1 the particle takes the shape of an octahedron, exponents 

𝑏1 = 𝑏2 = 2 lead to an ellipsoidal shape, and for higher exponents the shape approaches 

a rectangular box.  

 

 

Parameters between 0 and 1 lead to a concave surface and might decrease the size 

defined by the diameters. Thus, it is recommended to use values of at least 0.5. 

 

Blockiness 1 describes the shape in the plane defined by Diameter 1 and 

Diameter 2 as shown on the right and the plane described by Diameter 1 and 

Diameter 3. Blockiness 2 describes the shape in the plane described by the 

diameters Diameter 2 and Diameter 3. 
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Point Mode, Number of Random Points, Match Enclosing Object Volume 

To generate Convex Polyhedrons, several random points (Number of Random 

Points), serving as vertices of the polyhedron, are placed inside the chosen 

Enclosing Object.  

 

The Point Mode defines if the vertices of the polyhedron can be defined anywhere 

inside the Volume of the enclosing object, or if they must lay on its Surface. 

 

 

 

 

 

Additionally, checking Match Enclosing Object Volume scales the object size until 
the volume is as big as the volume of the enclosing object. Leaving this option 

unchecked always leads to a smaller volume.   

Diameter 1 Diameter 2 
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Scaling Factor and Browse for Combined Object 

Combined Objects are created through the combination of two or more objects 

(which have the same or different object types). They must be generated beforehand 
with GadGeo and saved in GAD-format. To learn how to generate combined objects 

with GadGeo refer to the GadGeo handbook of this User Guide. 

Click Browse … in the right column of the Object Type panel to select and import 

combined objects from a *.gad-file. The Christmas tree example for combined objects 

is included in the installation folder. 

 

The Scaling Factor controls the size of the objects. A scaling factor of 1 generates 

the selected combined object with original size. 

 

Orientation  

All objects in the generated granular structure have either isotropic or anisotropic 

orientation. The Orientation of an object type in a generated structure can be set by 

clicking the Edit… button. The orientation can be separately set for each object type 

so that differently oriented objects may coexist within the same structure. 

In the Orientation dialog, objects can be defined to be Isotropic, have a certain 
Anisotropic Direction, Anisotropic Orientation, Given Directions, are oriented 

In XY-Plane or have a maximum Angle Around Direction. See how to set the 

values for Anisotropy 1 and 2 (pages 53ff.) 

For all object types, either with a rotationally symmetric cross-section (such as 

Circular and Hollow fibers), or with rotationally asymmetric cross-sections, it is 

possible to control the object direction (isotropic or anisotropic) and the position of 

the cross-section with respect to the XY-plane as well (see below, page 47). 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GadGeo&release=2023&heading=GadAdd
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Isotropic 

In an Isotropic orientation, all directions 

have the same probability. 

 

 

 

 

 

 

 

Anisotropic Direction 

When checking Anisotropic Direction and selecting Anisotropy Parameter from 

the Direction Mode pull-down menu, the Anisotropy Parameters (Anisotropy 1 

and Anisotropy 2, see pages 53ff.), as well as the Phi, Theta and Psi Euler Angles 

for the three-dimensional rotation of anisotropic objects can be defined.  

In this case, the positions of cross-sections to the XY-plane are isotropic (and not 

entered). 

The Euler rotation angles are applied to 

the objects during the generation 
following the order Phi → Theta → Psi.  

 

 

 

http://en.wikipedia.org/wiki/Euler_angles
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Z-axis fixed new X-axis fixed new Z-axis fixed 

Phi applies rotation 

around existing Z-axis 

Theta applies rotation 

around the new X-axis 

Psi applies rotation 

around the new Z-axis 

 
  

Alternatively, when selecting Orientation Tensor from the Direction Mode pull-

down menu, the values for the direction tensor of the anisotropic objects can be 

entered.  

The Orientation Tensor provides an equivalent alternative to the combination of the 

Anisotropy Parameters and the Euler Angles.  
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Clicking Normalize + Calculate Anisotropy Parameters button enters the 

adjusted values in the orientation tensor and the Anisotropy 1 and Anisotropy 2 boxes.  

In detail, let 𝒅𝒌 = (

𝑥𝑘

𝑦𝑘

𝑧𝑘

) be the unit vector describing the direction of the kth objects 

and 𝒏 the number of objects. Then the orientation tensor 𝑻 is the sum over the dyadic 

products of the 𝒅𝒌 from all 𝑛 objects, divided by 𝑛: 

𝑻 =  
1

𝑛
(∑ 𝒅𝒌𝒅𝒌

𝑻𝑛
𝑘=1 ) =  

1

𝑛
∑ (

𝑥𝑘𝑥𝑘 𝑥𝑘𝑦𝑘 𝑥𝑘𝑧𝑘

𝑦𝑘𝑥𝑘 𝑦𝑘𝑦𝑘 𝑦𝑘𝑧𝑘

𝑧𝑘𝑥𝑘 𝑧𝑘𝑦𝑘 𝑧𝑘𝑧𝑘

)𝑛
𝑘=1 =  (

𝑡11 𝑡12 𝑡13

𝑡21 𝑡22 𝑡23

𝑡31 𝑡32 𝑡33

). 

The diagonal elements define the orientation strength for the corresponding directions 
and sum up to 1. Thus, if for example 𝑡11 = 1 (and 𝑡22 = 𝑡33 = 0), all objects are oriented 

in the X-direction. For 𝑡11 = 0 all objects are oriented normally to the X-direction and 

same values for all diagonal elements (𝑡11 = 𝑡22 = 𝑡33 =
1

3
) result in a uniform 

distribution for the object orientation. 

 

Observe the effect of changing the shown values of the isotropic Orientation Tensor 

to obtain anisotropic structures oriented in:  

 

 

Z-direction 

Y-direction 

X-direction 
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Anisotropic Orientation 

To control not only the object direction, but also the position of the cross-section with 

respect to the XY-plane, check Anisotropic Orientation and select either 

Anisotropy Parameter or Orientation Tensor from the Orientation Mode pull-

down menu.  

The angle between the object cross section axis and XY-plane can be entered in the 

Profile Angle to XY-Plane dialog. 

 

 

The object Profile Angle to XY-Plane, can be set to be a Constant value, or to 

follow a distribution (Uniformly in interval, Gaussian, or Probability 

Distribution). 

 

 

Profile Angle to XY-Plane 

X 

Y 
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Observe the effect of varying the Profile Angle To XY-Plane in a structure made of 

Short Elliptical fibers strongly oriented in the Y-axis (Anisotropy 1 = 1, Anisotropy 2 

= 1000). Other parameters are unchanged.  

 

In the following example, a Probability Distribution is defined. 50% of the elliptical 
fibers are at an angle of 45º with the XY-plane, 30% lie on the plane (0º angle), and 

20% are at a 25º angle. 
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Given Directions 

By checking Given Directions, a distribution gradient can be entered for different 

direction vectors for the objects in the generated structure.  

In the left column the Count Probability can be entered. A value of 1 means all 

objects will have the given direction on the right. For example, a Count Probability 

of 1 for the direction vector 0, 0, 1 means that all objects follow the Z-direction, and 

1, 0, 0 means that all objects follow the X-direction. 

 

If more rows are given, every given direction will be applied to the generated objects 

with the corresponding count probability. In the following example observe how 80% 

of the short circular fibers are oriented in X-direction while the other 20% are oriented 

along the Z-axis.   

 

Clicking the Normalize button ensures the Count Probability values sum up to one. 

The Given Directions distribution settings can be saved and loaded by clicking Save 

and Load, respectively. 
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Every direction in the 3-dimensional space is possible, as seen in these examples: 

 

 

 

 

In XY-Plane 

By checking In XY-Plane, the angle of the objects main axis in the XY-Plane can be 
set. The objects lay on the XY-Plane and their main axis orientation in relation to the 

X-direction is controlled by the entered value. 
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For example, enter 0, 30, 45, or 90, to obtain the following orientations in the XY-

Plane: 

Angle Around Direction 

If Angle Around Direction is checked define the Main Direction Vector of the 

objects generated in the structure. The orientation of the objects can vary if an Angle 

Around Direction is given.  

The Angle Around Direction defines the maximum angle the object orientation 

varies from the Main Direction.  
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Observe how the orientation varies in the following example with angles around 

direction of 0°, 5° and 10° and a Main Direction Vector of (1, 0, 0). 
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Setting Anisotropy Parameters 

The Anisotropy Parameters, Anisotropy 1 (𝑎1) and Anisotropy 2 (𝑎2), allow to 

define the orientation of the grains. Anisotropy parameters and the Orientation Tensor 

are equivalent representations for the orientation, and GeoDict can compute one from 

the other automatically. The grains are created with random orientations, following a 

distribution defined by the given parameters. 

The Algorithm 

For each grain, a random direction is computed 

𝑑 = (
𝑥
𝑦
𝑧

 ) 

which follows an isotropic distribution. Afterwards the Anisotropy Parameters are 

used to influence these orientations. Before normalization, the resulting vector for the 

grain orientation is:  

𝑑𝑎 = (

𝑥𝑎

𝑦𝑎

𝑧𝑎

) = (
𝑎1 ∙ 𝑥

𝑎1 ∙ 𝑎2 ∙ 𝑦
𝑧

 ) 

With normalization follows: 

𝑑𝑛𝑜𝑟𝑚𝑎𝑙𝑖𝑧𝑒𝑑 =
1

|𝑑𝑎|
𝑑𝑎 =

1

√(𝑎1𝑥)2 + (𝑎1𝑎2𝑦)2 + 𝑧2
(

𝑎1𝑥
𝑎1𝑎2𝑦

𝑧
 ) 

Before normalization, Anisotropy 1 controls the first two coordinates, while 
Anisotropy 2 only affects the second coordinate and none of them changes the third. 

After normalization, the anisotropy parameters both have impact on all three 

coordinates, where the influence on the grain direction differs. Whereas high values 

for Anisotropy 1 lead to grains parallel to the XY-plane, high values for Anisotropy 

2 result in grains oriented in Y-direction. Grains oriented in Z-direction are obtained 
by low values for Anisotropy 1 and low values for Anisotropy 2 result in grains 

parallel to the XZ-plane. 

In the following five main cases for the Anisotropy parameters are described: 

Anisotropy 1 = Anisotropy 2 (Isotropic material) 

The grain orientation is isotropic. All directions have the same probability, as the 

direction obtained from the random algorithm is not changed: 

𝑑𝑎 = (
𝑎1𝑥

𝑎1𝑎2𝑦
𝑧

 ) = (
1 ∙ 𝑥

1 ∙ 1 ∙ 𝑦
𝑧

 ) = (
𝑥
𝑦
𝑧

 ) = 𝑑 
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Anisotropy 1 < 1  

Values smaller than 1 for Anisotropy 1 lead to orientations in Z-direction, so that 

the grains are parallel to the YZ-plane and the XZ-plane when viewed from the X- or 

Y-direction. The smaller the value of Anisotropy 1, the more anisotropic the grains 

behave. 

For example, with the values 0.01 for Anisotropy 1 and 1 for Anisotropy 2 it 

follows: 

𝑑𝑎 = (
𝑎1𝑥

𝑎1𝑎2𝑦
𝑧

 ) = (
0.01 ∙ 𝑥
0.01 ∙ 𝑦

𝑧
 ) 

Thus, after normalization the direction vectors of the grains approximate the unit 

vector: 

𝑑𝑛𝑜𝑟𝑚𝑎𝑙𝑖𝑧𝑒𝑑 =
1

√0.0001 ∙ 𝑥2 + 0.0001 ∙ 𝑦2 + 𝑧2
(

0.01 ∙ 𝑥
0.01 ∙ 𝑦

𝑧
 ) ≅ (

0
0
1

 ) 

That results in grains oriented in Z-direction. 
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Anisotropy 1 > 1  

The grains are isotropic in the XY-plane (Z-slice). The higher the value of Anisotropy 

1, the stronger is the anisotropy.  

For example, with the values 100 for Anisotropy 1 and 1 for Anisotropy 2 it follows: 

𝑑𝑎 = (
𝑎1𝑥

𝑎1𝑎2𝑦
𝑧

 ) = (
100 ∙ 𝑥
100 ∙ 𝑦

𝑧
 ) 

Thus, after normalization the direction vectors of the grains approximate the vector: 

𝑑𝑛𝑜𝑟𝑚𝑎𝑙𝑖𝑧𝑒𝑑 =
1

√10000 ∙ 𝑥2 + 10000 ∙ 𝑦2 + 𝑧2
(

100 ∙ 𝑥
100 ∙ 𝑦

𝑧
 ) ≅ (

𝑥
𝑦
0

 ) 

That results in grains oriented in the XY-plane. 

 

Anisotropy 2 < 1  

Small values for Anisotropy 2 lead to grains oriented parallel to the XZ-plane. 

Observe that the grains are isotropic in the XZ-plane (Y-slice). 

For example, with the values 1 for Anisotropy 1 and 0.01 for Anisotropy 2 it 

follows: 

𝑑𝑎 = (
𝑎1𝑥

𝑎1𝑎2𝑦
𝑧

 ) = (
𝑥

0.01 ∙ 𝑦
𝑧

 ) 

Thus, after normalization the direction vectors of the grains approximate the vector: 

𝑑𝑛𝑜𝑟𝑚𝑎𝑙𝑖𝑧𝑒𝑑 =
1

√𝑥2 + 0.0001 ∙ 𝑦2 + 𝑧2
(

𝑥
0.01 ∙ 𝑦

𝑧
 ) ≅ (

𝑥
0
𝑧

 ) 

That results in grains oriented in the XZ-plane. 
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Anisotropy 2 > 1  

The higher the values for Anisotropy 2, the more the grains tend to be oriented 

along the Y-axis. Observe that the grains cut the XZ-plane (Y-slice), while they run 

parallel to the YZ-plane and the XY-plane when viewing them from the X- or the Z-

direction. 

For example, with the values 1 for Anisotropy 1 and 100 for Anisotropy 2, it 

follows: 

𝑑𝑎 = (
𝑎1𝑥

𝑎1𝑎2𝑦
𝑧

 ) = (
𝑥

100 ∙ 𝑦
𝑧

 ) 

Thus, after normalization the direction vectors of the grains approximate the unit 
vector: 

𝑑𝑛𝑜𝑟𝑚𝑎𝑙𝑖𝑧𝑒𝑑 =
1

√𝑥2 + 10000 ∙ 𝑦2 + 𝑧2
(

𝑥
100 ∙ 𝑦

𝑧
 ) ≅ (

0
1
0

 ) 

That results in fibers oriented in Y-direction. 
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Different anisotropy values for different object types 

As mentioned before, the orientation can be separately set for each object type so 

that differently oriented objects may coexist within the same structure. In the 
following structure, observe that Anisotropy 1 and Anisotropy 2 are set to 0.01 

and 1 for the short circular (red) fibers. The short circular (gray) fibers have 

Anisotropy 1 and Anisotropy 2 of 1 and 100, respectively. 

The red fibers tend to be oriented along the Z-axis, and the fibers run parallel when 

viewed from the X- or Y-direction. 

The gray fibers tend to be oriented in the Y-axis and cut the XZ-plane, while they run 

parallel to the YZ-plane and the XY-plane, as observed from the X- or the Z-direction. 
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Center 

The position of objects in a structure created 

with GrainGeo can be controlled by adjusting 

the position of their Center through the 

Edit… button. 

The Center of the objects may be distributed 
Uniformly, Uniformly in Box, or follow a 

Density Distribution.  

 

 

Uniformly 

When Uniformly is checked, the random object center values are uniformly 

distributed across the whole structure. The uniform distribution of the centers is 

clearly observed in the example below. 

On Current Objects 

After having selected Create in Current Domain under the Create Options tab, 

the centers can also be positioned On Current Objects. 
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Observe the placement of short circular fibers’ centers on a conical structure 

generated with GadGeo, when On Current Objects is chosen in the Center dialog. 

Uniformly in Box 

With Uniformly in Box checked, the values entered for X-min, X-max, Y-min, Y-
max, Z-min and Z-max limit the distribution of the center position to certain areas. 

These directionally limiting values define an area in which the structure occurs.  

For a 200 x 200 x 200 µm structure, the values in the Center dialog limit an area in 

which the respective ellipsoid center is positioned between 20 µm and 100 µm in the 

X-direction, 30 µm and 100 µm in the Y-direction, and between the origin (0 µm) and 

the end of the domain in the Z-direction.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Density Distribution 

The Density Distribution table describes the probability of a random center taking 

certain position values in Z-direction.  

When checking Use Relative Position in the density distribution table, the left 

column values (from 0 to 1) correspond to locations in the structure. In the Z-

direction, the value 0 is at the origin and the value 1 is at the end of the domain. 

The right column assigns relative density values at these locations. The value 20 

means that there are ten times more objects in Z = 1 than in Z = 0.1, with a density 
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value of 2. The object density increases and decreases linearly between the given 

locations in the Z-direction. 

Observe how, with the values entered in the table (0.1 → 20, 0.5 → 0, and 1 → 0.2), 

most pyramids occupy an area in the structure near the Z-origin (Z = 0.1), then there 

is an area almost empty of pyramids in the middle (Z = 0.5), and only some pyramids 

are at the end of the domain in Z-direction (Z = 1).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

As before, with orientation, the distribution of centers can be separately set for each 

object type so that differently distributed object types may coexist within the same 

structure.  

In the following example, observe that the gray 

ellipsoids are distributed Uniformly in Box, 

whereas the red pyramids follow a Density 

Distribution. 

 

 

 

 

 

 

With Use Relative Position un-checked, the left column values of the density 

distribution table correspond to absolute locations in the structure.  

In the Z-direction, in a structure of size 200 x 200 x 200 µm, the value 0 is at the 

origin and the value 200 is at the end of the domain. The right column assigns density 

0.0 

0.1 

 
 

0.5 

 

 

1.0 
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values at these locations, where 0 means that pyramid centers are absent at that 

location, and 1 means that pyramid centers are present at the location. 

 

Observe how, with the values in this table, the pyramids are distributed. The object 

density increases and decreases linearly between the given locations in the Z-

direction. 

 

 

 

 

 

 

 

 

 

 

 

 

 

The center density distribution must be defined with 

monotonously increasing Z-values. 

If Z is non-monotonic or monotonously decreasing, 

an error message appears when trying to generate 
the structure. 
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Rounded Endings 

Short fibers with any cross-section (Circular, Hollow, Rosetta, Cellulose, Elliptic, 

Rectangular and Angular) can be created with or without rounded ends by checking 

or leaving un-checked the Rounded Endings box. Observe the variation in the shape 

of the short rectangular fibers after checking the Rounded Endings box. 

 

 

 

 

 

 

 

 

 

Couple Diameters, Couple Lengths, and Couple Diameter and Length 

The diameters of ellipsoids, the lengths of boxes, and the Diameter/Length of short 

circular, hollow, angular, rosetta, elliptical, and cellulose fibers, or the Side 

length/Length of short rectangular fibers can be coupled by checking Couple 

Diameters, Couple Lengths, and Couple Diameter and Length or Couple Side 

Length 1 and Length.  

Then, the boxes for the values of Diameter, Length, or Side Length disappear and 

an Edit... button appears. Click the Edit… button to couple these parameters through 

values entered in a probability distribution table. 

The following structure, entirely made of short circular fibers, is generated with the 
coupled values for diameter and length entered in the probability distribution table 

shown.  
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Observe the three distinct sizes of short circular fibers: 50% with diameter 10 µm 

and length 200 µm, 20% with diameter 50 µm and length 100 µm, and 30% with 

diameter 25 µm and length 100 µm. 
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OBJECT OVERLAP 

The options under the Object Overlap tab define the material IDs in locations where 
materials in the structure overlap. The overlap locations can have other properties 
than the original materials. 

  

The Material ID Mode pull-down menu allows to select between two modes. 

Material ID per Material means that all objects with the same material receive the 

same Material ID. Material ID per Object-Type means that objects with different 
type obtain different Material IDs, even if they are made of the same material.  

 

 

 

Assigning a Material ID is part of the GeoDict Material Database concept, in which 
objects in the structure are ascribed to an individual material (e.g. glass, iron, PET) 
with specific physical properties. 

If Resolve Overlap is checked, the overlap is not assigned to a new material ID. 

Instead, the water-shed algorithm is used to decide which of the overlap voxels 
belongs to which object in a post-processing step. Thus, each overlap voxel is 

assigned to one specific object. This option needs more memory and a longer run-
time. 

In detail, the Resolve Overlap algorithm starts with computing a distance map for 

the overlap voxels, i.e. it computes the distance to the next object for each overlap 

voxel. On this distance map the watershed algorithm is run using all voxels belonging 

to an object as seeds. There, all voxels contained in the same object have the same 

material ID. Thus, the overlap area is filled with the object IDs according to the 
distance map.  

To mark the contact voxels between the objects with a separate material ID, select 
Mark Contact Voxels and choose a Contact Material from the Material Data Base. 

The voxels, where two or more object IDs meet, are marked as contact voxels, by 

reassigning them with a new material ID. Thus, the layer of contact voxels always 
has a thickness of two voxels. 

 

 

In the following observe the resulting Material IDs for the overlap for not resolved, 
resolved, and resolved overlap with marked contact voxels, while all other settings 
are kept the same. 
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Default Overlap Material defines the default ID of the new material, which will be 

assigned to the regions where newly generated objects overlap each other and/or the 
existing structure. When only one object type is present, the overlap material is 

automatically set to the material of the chosen object type. Furthermore, the material 

ID is automatically set to the material ID of this object type, when Material ID per 

Material is selected. 

 

 

The Number of Overlap Rules allows to individually define rules for the 

reassignment of material IDs during overlap operations. In the example shown above, 

three rules have been defined: The overlap of objects with material ID 1 (red) will be 

assigned to ID 3 (blue). The overlap of objects with material ID 2 (gray) will be 

assigned to ID 4 (orange) and the overlap of ID 1 and ID 2 will be assigned to ID 5 

(magenta).  
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Note, that the results for volume in the resulting report do not change for different 

overlap rules, as the values are computed before the overlap rules are applied. For 
the values in the result file, the GAD objects are considered, while for the final voxel 

structure the overlap is handled according to the overlap rules defined in the Object 

Overlap tab. 

In the three examples given for Resolve Overlap, the Absolute Object 

Distribution is shown here. 

 

 

 

 

 

 

 

 

 

 

For the volume percentages of the final structure refer to the Statistics tab above of 

the visualization area in GeoDict. 

Here, the volume statistics are shown for the example with default overlap rules. The 

red fiber has 3.55 % of the volume, the gray fiber has 5.81 % and the overlap 1.73 

%. 

 

 

 

 

 

 

 

In the result file the overlap volume is proportionally 

added to the volume of the overlapping fibers.  

Here, the red fiber obtains 3.55% + (1.73/2)% = 

4.415%. Rounded, this results in the 4.42 % shown in 

the report.  
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RESULT OPTIONS 

GrainGeo always saves the generated structure as a GeoDict structure file (*.gdt) 
(GeoDict binary data). The file is placed in an automatically created result folder inside 

the chosen project folder (File → Choose Project Folder... in the menu bar).  

The result file as well as the result folder take the name entered as Result File Name 

(*.gdr) at the bottom of the dialog.  

An additional option to save the generated structure data is to check Save 

Intermediate Result every and enter a number of Objects in the box. As objects 

are added to the structure during the generation, an intermediate result file is saved 

every time the number of placed objects reaches the entered value. 

 

This option may be interesting when studying the properties of a series of structures 

with increasing density.  

After running the generation, the intermediate geometries can be found as *.gad 

analytic files in the result folder and can be loaded directly from the Result Viewer of 

the *.gdr result file. 

 

 

 

 

 

The parameters entered in the GrainGeo Create Options dialog can be 

saved into *.gps (GPS, GeoDict Project Settings) files and/or loaded from 

them. Remember to restore and reset your (or GeoDict’s) default values 

through the icons at the bottom of the dialog when needed and/or before 

every GrainGeo run.  

Resting the mouse pointer over an icon prompts a Tooltip showing the icon’s 

function to appear. 
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PILE GRAINS 

When choosing Pile Grains from the pull-down menu in the GrainGeo section, 

objects fall from their initial positions during the structure’s generation and form a 

piled granular structure.  

Clicking the Options’ Edit… button opens the GrainGeo Pile Options dialog.  

When the desired parameters have been entered, 

clicking OK closes the dialog and returns to the 

GrainGeo section. There, clicking Generate 

starts the piling process. 

 

 

 

 

 

 

At the top left of the GrainGeo Pile Options dialog, the name for the files containing 

the generation results can be entered in the Result File Name (*.gdr) box. The 

default name can be kept, or a new name can be chosen fitting the current project. 

The available units (m, mm, µm, nm, and Voxel) are selectable at the top right of 
the dialog. When the units are changed, the entered values are adjusted 

automatically. 
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The Pile Options are organized under four tabs:  

◼ Pile Options: Determine physical properties of the resulting structure model such 
as size, resolution, overlapping mode, and solid volume percentage.  

◼ Object Options: Define the geometrical properties of individual object types such 

as cross-section, length, and orientation. Up to 254 different object types can be 
used in one structure. 

◼ Object Motion: Controls the way the objects are piled. This is done by defining 
e.g. different step parameters and the initial object position.  

◼ Result Options: Determine how the result files are saved. 

PILE OPTIONS 

The parameters defining the general properties of the granular structure are entered 

under the Pile Options tab. They are grouped into Domain, Generation and 

Overlap Mode, and Stopping Criterion panels. 

 

PILE IN CURRENT DOMAIN AND KEEP CURRENT OBJECTS / STRUCTURE 

When checking Pile in Current Domain, the structure currently in memory, is taken 

as domain for piling a new structure. Additionally, when Keep Current Objects / 

Structure is checked, the structure in memory is kept and combined with the newly 
piled structure, otherwise it is discarded after the piling step. Piled grains will not 

overlap. 

Notice that the size parameters, grouped under the Domain panel, cannot be 

modified when Pile in Current Domain is checked, because they are kept from the 

structure already in memory. 
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Observe the effect that checking or leaving un-checked Pile in Current Domain and 

Keep Current Objects / Structure has on the generation of a piled granular 

structure. 

A structure composed of ellipsoids is already in memory 

when spheres fall from the Z+ direction.  

 

 

 

When piling on the copper ellipsoids (current structure), 

the steel spheres fall on the copper ellipsoids, and some 

do not reach the bottom. When not piling on the copper 

ellipsoids (current structure), the steel spheres fall all 

the way to the bottom of the domain.  

 

DOMAIN 

The Domain panel contains the parameters defining the structure size (NX, NY, and 

NZ) in combination with the resolution (Voxel Length), as well as the Origin 

parameters, Center Domain, and the Periodicity checkboxes. The periodicity boxes 

are disabled (and checked) for Pile, because the objects are always piled periodically. 

 

NX, NY, NZ, and Voxel Length  

The internal representation of a structure in GeoDict consists of rectangular 3D arrays 

of equally sized boxes, hereafter called volume elements or voxels. NX, NY, and NZ 

are the number (N) of voxels in X, Y and Z directions.  
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The Voxel Length is the size of one voxel in the chosen units. Varying the values for 

NX, NY, and NZ has the effect of changing the size of the piled structure in the given 

direction. 

 

 

 

 

 

 

 

Low values for voxel length in combination with high values for NX, NY and NZ result 

in a higher resolution, but also in a higher computational time. After setting the values 

of NX, NY, and NZ, and Voxel Length, the physical structure size is automatically 

displayed in the chosen units. 

 

Observe how keeping the structure size a constant 100 x 100 x 100 µm3 while 

decreasing the Voxel Length from 0.5 µm to 0.25 µm has the effect of refining the 

spheres in the pile by increasing the resolution. Since the voxel length has decreased 

to half, the size of the structure is kept by doubling the NX, NY, and NZ values from 

200 to 400. 
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Origin X, Origin Y, and Origin Z, and Center Domain 

The Origin X, Origin Y, and Origin Z parameters, together with the Center Domain 

button, determine the placement of the piled structure in the physical space in the 

same way as seen above for GrainGeo – Create Grains (page 8). 

GENERATION AND OVERLAP MODE 

The options in the Generation and Overlap Mode panel control the relative position 

among objects (or with the structure currently in memory). 

Objects may touch (but not overlap) when Prohibit Objects Overlap is selected. 

Objects may not touch when Use Isolation Distance is selected, and a positive 

value is entered. Then, all objects have at least this preset distance. The choice of 

Use Isolation Distance may lead to long computation times for large structures. In 

contrast to Create Grains, negative values for the Isolation Distance are not 

allowed. 

 

STOPPING CRITERION 

The parameters in the Stopping Criterion panel control the criterions which stop the 
piling process. The analysis of the results file (GDR file) shows any disparity between 

the achieved result values and the desired ones. 

Besides the same options available for GrainGeo – Create Grains (pages 22ff.), it is 

also possible to choose Fill to Rim.  
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Fill to rim 

Fill to Rim continues the piling process until the 

objects reach the top of the bounding box in the Z-

direction. 

 

 

 

 

 

 

RANDOM SEED 

Random Seed initializes the random number generator used by the structure 
generator. Changing its value produces different sequences of random numbers and 

hence, different realizations of the specified structure. If all settings are equal, 

generating with the same Random Seed value produces an identical structure. 

Random Seed is a non-negative integer number.  

Varying the Random Seed allows generating different samples of the same granular 

structure. In the following examples, all parameters are unchanged while the Random 

Seed is changed (here: 6, 22, 55). 

 

 

 



Generate and model granular structures with GrainGeo 

74  GeoDict 2023 User Guide 

OBJECT OPTIONS 

The objects available to pile granular structures (Pile) are organized and listed in 
panels in a way almost identical to the one for creating granular structures (Create). 

See the detailed explanations above, page 26ff. Up to 254 different object types may 

be added to the same structure. 

 

The center position of the objects is a result of the piling process and cannot be 

specified. 
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OBJECT MOTION 

The Object Motion parameters control the objects’ movement and initial position 
during the piling process, and are grouped into the Piling Step, and the Object 

Position panels. The Pile Mode can be selected from the pull-down menu. 

 

PILING STEP 

The object movement during the piling process is mainly defined by the falling 

Direction and by the automated finding of a stable minimum (Find Stable 

Minimum).  

When the result is unsatisfactory, additional parameters can be used to refine it 

(Number of Shifts, Maximum Shift Angle, Number of Rotations per shift, 

Maximum Rotation Angle and Maximum Check Length). 

 

 

 

 

 

 

 

 

 

 

Find Stable Minimum is not available when all objects fall at the same time (Pile 

Mode → All Objects at Once). Maximum Check Length is only available if Find 

Stable Minimum is checked. 

Direction  

The direction in which the piling process happens can be chosen from the pull-down 

menu. For all three axes, the objects fall towards the positive direction (X+, Y+, or 

Z+). Observe the piling of spheres with On Inflow Plane Center as initial object 

position, falling from all three directions. 
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Number of Shifts, Maximum Shift Angle, Number of Rotations, Maximum Rotation 

Angle 

Throughout the piling process, the objects fall in the specified direction and roll to 

their final location in the granular structure. After the fall, i.e. after hitting an obstacle 

as the bottom domain boundary or another object, the objects shift and rotate as 

many times as defined by the values for Number of Shifts and Number of 

Rotations before they come to rest at the bottom of the structure. Low values for 
shifts and rotations produce structures with objects that settle earlier compared to 

larger values of these parameters, resulting in a lower packing density. 

In detail, the algorithm for each shift tries the given number of rotations. If a better 

position is found for the object, lower in the specified direction and without 

overlapping with other objects, it is used as a new point for the object. Then, the 

numbers of shift and rotation are reset. The algorithm terminates if no new position 

is found for the given number of shifts and rotations.  

Observe the effect of setting a low or a high Number of Shifts value on the final 

position of ellipsoids in a piled structure. 

 

 

 

 

 

 

 

 

The Maximum Shift Angle restricts the angle that the objects can shift with respect 

to the piling direction. Thus, the object always moves downwards.  

The Maximum Rotation Angle describes the maximum angle the objects can rotate 

from step to step. The object is rotated around the center defined for the object, 
which in most cases is the center of mass. Spheres are not rotated, as it would not 

have any effect on the results. 

 

 

 



GrainGeo – Pile Grains 

GeoDict 2023 User Guide  77 

Find Stable Minimum and Maximum Check Length 

When checking Find Stable Minimum, each object is checked to have a stable state 

with respect to gravity at the end of the piling process. 
The position of an object is considered as unstable, if it 

is possible to move it vertically (perpendicular to the 

specified direction) without obtaining overlap with other 

objects, i.e. it does not have the lowest position possible. 

The Maximum Check Length is a further refinement 
when finding the stable minimum. For every object, the 

algorithm checks for an even more stable position around 

the already reached minimum with a radius defined by 

the voxel value entered in the field. A higher value 

increases the stability of the pile. 

Observe the effect of checking or un-checking Find 

Stable Minimum, and then entering increasing values of Maximum Check Length 

(1, 3, and 10) in the piling of 100 boxes with initial object position On Inflow Plane 

Center. 

While it is faster to pile structures when Find Stable Minimum is un-checked, the 

resulting packing densities are lower. 

Observe the change in realized Volume [%] value (shown in the result file under the 

Results Info tab) when Find Stable Minimum is checked or un-checked, if all other 
parameters stay the same, including Random Seed. The initial object position is On 

Inflow Plane, and Fill To Rim is the stopping criterion. The final structures look 

similar, but the realized solid volume percentages differ significantly. 
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PILE MODE AND OBJECT POSITIONS 

Select from the pull-down menu whether the objects should fall one after another 

(Object after Object) or all should fall at once (All Objects at Once). 

When choosing Object after Object, the pull-down menu allows setting the initial 

position from which the objects are set to fall: From initial position plane (On Inflow 

Plane), from its center (On Inflow Plane Center), or from an existing structure 

(Objects from gad File). 

When piling objects On Inflow Plane or On Inflow Plane Center, and to increase 
the quality of the piled structure, the Maximal Number of Positioning Trials can 

be adjusted at the cost of additional runtime. 

 

 

 

 

 

 

 

 

 

 

When piling from an existing structure, the objects are those already in the structure 

and no objects (and their geometry parameters) need to be selected through the 

Object Options tab.  

 

 

 

 

 

 

 

 

Clicking Browse, a structure saved in GAD format can be selected as the source of 

the objects. 

When choosing All Objects at Once, the objects can only originate from the analytic 

data of an existing structure. 
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Assuming the Z-direction to be the piling direction, and downwards to be the positive 

direction (Z+), the following situations should be considered: 

 

Touching, but not overlapping, is allowed for piling. The initial 

structure must be generated without overlapping. For 
example, by selecting Remove Overlap when generating 

with GrainGeo → Create (or other GeoDict generators). 

 

 

 

 

Periodicity is needed in the X and Y 

directions for piling, to avoid undesired 

intersections at the edge of the 
structure. The initial GAD file must be 

generated to be periodic (in all 

directions). 

 

 

Objects are not allowed to drop off the 

bottom of the structure. When this 

happens, the dimensions of the initial 

*gad file must be processed to include 

the extruding object. 

 

 

 

This can be done by adding enough empty voxels in Z+ direction by using Model → 

ProcessGeo → Process → Embed (check Embed Analytic Objects to keep the 

GAD format) or by increasing the size of the domain in Z-direction Model → GadGeo 

→ Edit Domain.  

Structures in GAD format to be used for piling must conform to certain 

requirements (no overlapping, periodicity, no objects crossing bottom plate) 

and should be generated for later piling with these requirements in mind. 
Overlap can be removed after generation using GadGeo → Remove Object 

Overlap. 
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The number of voxels to be added depends on how far objects overlap the original 

domain in z-direction. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Before the piling process starts from a structure in GAD-format, the position of the 

objects it will contain can be slightly modified by two parameters. The distance 

Before piling, the domain size in the Z-direction under the Pile Options tab – 

Domain panel must be increased to adjust to the larger domain size of the 

modified GAD file.  

For example: 
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between the objects in the piling direction can be enlarged by the factor entered in 

Loosen Objects. Additionally, all objects can be lifted by the distance entered in Lift 
Objects. For example, these parameters can be used to generate structures similar 

to those from sieving processes combined with additional shaking.  

 

RESULT OPTIONS 

The pile Result Options on managing the saving of result and geometry files are 

completely analogous to the create Result Options explained above (page 67). 
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PACK ANALYTIC SPHERES 

When choosing Pack Analytic Spheres from the pull-down menu in the GrainGeo 

section, densely packed spheres are generated. GeoDict uses a force-biased algorithm 

to create the dense packing [1]. 

The necessary parameters can be entered in the GrainGeo - Pack Options dialog, 

after clicking the Options’ Edit… button. When the desired parameters have been 

entered in the Pack Analytic Spheres dialog, clicking OK closes the dialog and 

returns to the GrainGeo section. There, clicking Generate starts the process. 

A Result File Name (*.gdr) should be entered to differentiate the results of every 

run of previous computations. The GDR (GeoDict result) files contain complete 

information on packing parameters, achieved packing density, and packing process 

file names. 

The available units (m, mm and µm) are 

selectable from the pull-down menu.  

The parameters for the packing process are 

organized in two tabs: Pack Options and Sphere 

Distribution.  
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The general properties of the packed structure are 

entered under the Pack Options tab. These parameters 
are grouped into the panels Domain, Materials, 

Packing, and Analysis. 

 

 

In the Domain panel, enter the values for NX, NY and 
NZ, indicating the number of voxels that the packed 

structure should have in the X, Y, and Z-direction, 

respectively. 

Change NX, NY and NZ by direct insertion or by clicking 

the arrow buttons. 

From the Packing Mode pull-down menu, select to Create New Packing or to Re-

Compact Existing Packing. 

 

 

 

Choosing to re-compact an existing packing enables to Browse and load the GDR 
result file from a previously run packing process. This GeoDict result file, and 

corresponding result folder, already include the packing parameters. 

CREATE NEW PACKING 

The spheres are packed into a new structure. The available parameters for the 

generation are listed and explained below.  

PACK OPTIONS 
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Materials 

Material ID Mode: The pull-down menu allows selecting between applying the 

Material ID based on the materials or the types of objects present in the packed 

structure. Changing from the default Material ID per Material to Material ID per 

Object-Type allows assigning a Material ID to the spheres based on their size 

(diameter). This is part of the GeoDict Material Database concept, in which objects in 
the structure are ascribed to an individual material (e.g. glass, iron, PET) with specific 
physical properties. 

 

By clicking the button to the right of Pore/Matrix Material (ID 00), it is possible 

to change the material ID assigned to the pore space/matrix surrounding the objects 
in the structure from the default Air (Fluid) to any other material.  

 

 

Packing 

The Random Seed is a non-negative integer number that defines the random initial 

position of the spheres. Changing its value produces different sequences of random 

numbers and, hence, different realizations of the specified structure. If all settings 

are equal, generating with the same Random Seed value produces exactly the same 
structure. 

For Packing Density enter values between 0 and 1 (0% to 100% packing density).  

The parameter Maximal Iterations allows setting an upper limit to the number of 
steps for the packing process. 

The Maximal Run time (h) permits setting the upper time limit for the packing 
process. 
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Analysis 

Checking the boxes Save GeoDict Particle Trajectories for Animation of sphere 

motion (*gpt File) and Save Two-Point Correlation Information (*.tpc File), 

creates the respective files inside the results folder in the project folder.  

Checking Save GeoDict Particle Trajectories for Animation of sphere motion 

(*.gpt File) creates a file containing the sphere trajectories during the packing 

process. The particle trajectory file can be loaded for visualization.  

Since saving the sphere trajectories results in a significant slowing down of the 

packing process, while the files are opened and trajectories for every sphere are 

saved, there is no need to select this option unless knowing the trajectories is 

essential for the project.  

If Compute Object Contacts Information Based on Voxel Image is checked, 

GeoDict counts the number of sphere-to-sphere contacts by checking if a voxel 

belonging to one sphere is in direct contact with a voxel belonging to another sphere. 

This is reported as Voxel Contacts under the Results - Report subtab of the Result 

Viewer of the GDR result file, after the packing process has run.  

The Mean Coordination Number is the mean number of neighboring spheres that 
any sphere touches. It is computed as 2x the total Number of Contacts divided by 

the total Number of Spheres. Each contact needs to be counted twice, once for each 

sphere which participates in this contact. 

 

 

 

In the Results – Map subtab, detailed information on each contact is found. Under 
the VoxelContacts key, the index numbers of the two objects that are in contact 

with each other, and the number of contacting voxel faces of each contact is shown.   
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If Compute Contacts Number Information Based on Analytic Data is checked, 
GeoDict counts the number of sphere-to-sphere contacts by checking if the distance 

between the center points of the spheres is large enough. For numerical reasons, it 

is highly unlikely that two spheres will exactly touch each other. Rather, there will 

always be a small distance between them.  

For example, with a given Contact Distance of 0.5 µm, a sphere of diameter 20 
µm is defined to be in contact with a sphere of diameter 10 µm, if the distance 

between their center points is less than 15.5 µm.  

The chosen Contact Distance can be changed during post-processing. Smaller 

contact distances lead to less contacts found.  

 

 

 

 

In the Results – Map subtab, detailed information about each contact can be found. 

Under the AnalyticContacts key, the index numbers of the two objects that are in 

contact with each other are shown.   
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Statistical information saved when packing / piling analytic spheres 

Besides the result file, a results folder with the same name is created. In this 

directory, GrainGeo saves files from the packing or piling run (see below pages 93ff.) 

in the several formats. 

Some of these formats are optional and only saved if the corresponding checkbox in 

the Analysis panel of the Pack Options or Pile Options tab is checked. 

Information on the analytic and discretized (voxelized) sphere contacts is internally 

and automatically saved and appears in the Result Viewer of the result file (*gdr) 

under the Results – Report and the Results – Map subtabs. This includes such 

information as the contact distance, mean coordination number, the number of 

contacts, and a list of all sphere contacts. 

◼ *.txt are text files. Convergence.txt relates the convergence at a given time 

with a certain packing-density. Restart.txt contains information about the sphere 

distribution parameters to re-start the packing process. Result.txt contains the 

achieved packing density, which is set to zero for the piling process.  

◼ *.tpc (two-point correlation) file contains a list with the distance between all 

spheres. Optionally saved. 

◼ *.log files contain the chronological record of the packing process. 

◼ *.pde are parameter files that contain the input data for the external packing 

code. 

◼ *.gsd (GeoDict sphere distribution) files contain the diameter, probability and 

number of each distinct sphere type. 

◼ trajectories.gpt (GeoDict particle trajectory) files contain a record of the 

movement of the spheres during the packing (or piling). This file can be used to 

visualize the packing process. Optionally saved. 

◼ particles.gpp (GeoDict particle position) files contain information on the position 

of the spheres after the packing (or piling). Optionally saved. 
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◼ *.gad (GeoDict analytic data) files contain the analytic data about the geometry 

of the object packing, such as object Material ID, object type, object position, and 

(sphere) diameter. 

◼ *.gdt file containing the GeoDict 3D voxelized geometry of the object packing. 

 

Most of these output files can be opened in a text editor, such as Notepad++, 
for post-processing of statistical information 
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SPHERE DISTRIBUTION 

With Count Probability as the Probability Mode, the Probability value in the table 

refers to the number of spheres of a type. With Volume Probability, it refers to the 

volume of spheres of a type.  

 

 

Draw Mode controls how the number of each sphere type is determined: 

◼ Draw Spheres: A random generator sets the type of each sphere in the structure 

depending on the given probabilities. Thus, the number of spheres of each type 

depends on the Random Seed.  

◼ Compute Sphere Type Numbers: The number of spheres for each type is 

computed analytically, based on the probabilities, but without a random generator. 

The number of spheres of each type is the same for different Random Seeds. 

For example, choosing Count Probability and Compute Sphere Type Numbers 

and specifying that of 100 spheres, 70% should be 1 mm and 30% should be 0.5 
mm, exactly 70 spheres have a diameter of 1 mm and 30 spheres have a diameter 

of 0.5 mm. 
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In contrast, selecting Draw Spheres determines that for each of the 100 spheres in 

the example the type is randomly drawn. Thus, each sphere has a 70% probability to 
have a diameter of 100 µm, and a 30% probability to have a diameter of 50 µm. 

Therefore, the Achieved Distribution of type 1 is dependent on the Random 

Number, and binomially distributed around an expectation value of 0.7.  

 

Spheres refers to the number of spheres to be packed. 

Sphere Types determines the number of different sphere types to be packed.  

The distribution table contains the parameters for the different sphere types to be 

packed. The Diameter of each sphere type in the chosen units, and their 

Probability, as well as their Material can be directly entered. The parameters for up 

to 100 Sphere Types can be entered in the table.  

Given the previously entered number of Spheres, and the values for Diameter and 

Probability for the distinct sphere types, GrainGeo draws the number of spheres for 
each type (Sphere Number). Under the Achieved Distribution tab, the reached 

ratio for each type is shown.  

When working with Volume probability and strongly differing sphere diameters, it 

might happen that only a very small number of the larger spheres appears in the 

structure, or that they are completely missing.  

 

By clicking Suggest Sphere Number a number of spheres is proposed so that ratios 

close to the desired probabilities can be reached. Depending on the chosen 

parameters (as above, e.g. Volume Probability 

and strongly differing Diameters), the suggested 

number of spheres might be large.  

Click the Edit / Paste Distribution Table button 

to edit the values for Diameter and Probability 

(depending on the choice for probability mode, 

either Count Probability or Volume Probability) 

in the Edit Sphere Distribution dialog. 

Clicking Normalize ensures that the 

Probability values 

sum up to one. 
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Alternatively, the distribution can be pasted from other software, for example from 

Microsoft ExcelTM, or it can be loaded from a *.txt-file. With the Save… button, the 

distribution table can be written to a file. 

 

Checking Apply Gravity includes a simulation of gravitational force on the packed 

spheres after the packing process, so that the spheres “fall down” in the Z-direction 

from their positions in the packing. The effect of applying gravity to a packed structure 
is obvious for low packing density (under 30%). As the domain is always periodic for 

the packing, the spheres cutting the bottom of the domain reappear in the top. If this 

is not desired, use ProcessGeo Crop to crop the top of the domain.  
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RE-COMPACT EXISTING PACKING 

Re-Compact Existing Packing is useful when trying to achieve a higher packing 

density from an already existing packing result.  

When choosing this option, the Materials panel is missing but some Packing 

(Maximal Iterations, Maximal Run time, Packing Density) and Domain 

parameters under the Pack Options tab can be set. 

 

Under the Sphere Distribution tab, all parameters are directly entered from the 

selected GDR file and from the corresponding result directory of a previous GrainGeo 

run. Additionally, the user can choose to Apply Gravity. 
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PILE ANALYTIC SPHERES 

Many of the Options to pile analytic spheres are similar to the options shown above 

(pages 82ff.) to pack analytic spheres. For example, the options under the Materials 

and Analysis panels are identical. 

As explained above for the packing process, a 

Result File Name (*.gdr) must be entered to 

save the results of every piling process. This 

Result File Name is applied to both the results 
file (*.gdr), and to the results folder (and the files 

in it) that are placed inside the chosen project 

folder.  

The available units (m, mm, and µm) are 

selectable from the pull-down menu.  

The parameters for the piling are organized in the 

Pile Options and Sphere Distribution tabs.  
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Domain 

The Domain value for NX and NY can be chosen by direct 

insertion or by clicking the arrow buttons, to indicate the 

number (N) of voxels in X and Y-direction.  

Since the spheres fall from the Z- direction, the size value 

for Z is determined by the height of the pile of spheres and 

depending on the number of spheres to be piled.   

In the Voxel Length box, enter the length of the voxels 

in the selected units. 

 

Piling 

In the Piling panel, the Drop Position from Center or Random can be selected 

from the pull-down menu. When selecting Center, the spheres are dropped from the 

center of the X-Y plane, instead of being dropped from any random position on the 

plane. 

The following piled structure is generated with the default options and a Random 

Seed of 362. Click Generate in the GrainGeo section to start the piling process. 

 

 



GrainGeo – Stochastic Field Thresholding 

GeoDict 2023 User Guide  95 

STOCHASTIC FIELD THRESHOLDING 

When choosing Stochastic Field Thresholding from the pull-down menu, structures 

can be created by generating and segmenting stochastic fields. Clicking the Options’ 
Edit… button in the GrainGeo section opens the Stochastic Field Thresholding 

dialog.  

At the top left of the Stochastic Field Thresholding dialog, the name results for the 

file containing the generation results can be entered in the Result File Name (*.gdr) 

box. The default name can be kept, or a new name can be chosen, fitting the current 

project. 

The available units (m, mm, µm, nm and Voxel) 

are selectable from the pull-down menu at the top 

right of the Stochastic Field Thresholding 

dialog. When the units are changed, the entered 

values are adjusted automatically.  

 

 

 

 

 

The Stochastic Field Thresholding dialog is organized using three tabs:  

◼ Create Options: Determine general properties of the resulting structure, such 

as size, position, resolution, and solid volume percentage.  

◼ Custom Generation Options: Choose individual combinations of stochastic 

fields to create a custom random field. 

◼ Result Options: Determine if the random field should be saved in the result 

folder. 

Additionally, the panels Material and Preview are available in the right column of 

the dialog. 



Generate and model granular structures with GrainGeo 

96  GeoDict 2023 User Guide 

MATERIAL 

The generated structure consists of two materials. In the Material panel select the 

Bulk Material (ID 01) from the material data base. 

 

 

 

 

If Grammage, Density or Weight Percentage are selected for thresholding, also 
the Temperature can be edited. The temperature unit can be chosen as K, °C or °F. 

If Manual is chosen as material a Bulk Density must be entered.  

 

 

 

 

 

The Pore / Matrix Material (ID 00) is defined in the Domain panel. The material 

filling the pore space can be Solid, Porous, or Fluid. For a porous matrix material, 

a density can be entered, if grammage, density or weight percentage are chosen for 

thresholding.  

 

 

 

PREVIEW 

In the bottom right of the Stochastic Field Thresholding dialog a preview of the 

generated random field (gray values) and the segmentation result (red for Material 

ID 01) is displayed.  

 

 

 

 

The preview is automatically updated 

when changing the values for the 

Domain, Generation Mode and 

Thresholding parameters.  

The view direction can be selected from 

the pull-down menu for Axis. 
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CREATE OPTIONS 

The parameters defining the general properties of the granular structure are entered 
under the Create Options tab. They are grouped into the Domain, Generation 

Mode and Thresholding panels. 

 

DOMAIN 

The Domain panel contains the parameters defining the structure size (NX, NY, and 

NZ) in combination with the resolution (Voxel Length), as well as the Origin 

parameters and Center Domain.  

These options are the same as for the GrainGeo Create Options described on page 

6. 

In general, the structure is periodic. Only if the parameters define a domain smaller 

than the chosen correlation length(s), periodicity cannot be achieved. That is because 

a bigger structure is generated and cropped to the desired size. In that case, warning 

messages appear in the result viewer for the affected directions. The runtime and 

memory requirements increase, corresponding to the needed domain size.  
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GENERATION MODE 

The options in the Generation Mode panel control the distribution used for the 

stochastic field which is segmented to obtain the final structure. It is possible to 
choose Isotropic Gaussian, Anisotropic Gaussian, Isotropic Linear, 

Anisotropic Linear, or a Custom random field.  

Isotropic Gaussian 

An Isotropic Gaussian random field is used 

to create the structure. Enter the 
Correlation Length 𝛔 to define the standard 

deviation of the used Gauss kernel. With 

higher values the features of the generated 

structure become larger.  

 

In the following example observe how the feature size changes for two different 

correlation lengths, while all other parameters are kept the same. 

 

Anisotropic Gaussian 

An Anisotropic Gaussian random field is used to create the structure. Enter the 
Correlation Length for X-direction 𝛔𝐗, Y-direction 𝛔𝐘 and Z-direction 𝛔𝐙. These 

values define the standard deviations in each main axis of the used Gauss kernel. 

Higher values lead to larger pores. If the same value is entered for all three directions, 

it is the same as Isotropic Gaussian. 

 

 

 

 

 

 

 

 

 

 



GrainGeo – Stochastic Field Thresholding 

GeoDict 2023 User Guide  99 

In the following example, the values 3, 10 and 20 are used for 𝛔𝐗, 𝛔𝐘 and 𝛔𝐙 

respectively. Observe the different feature shapes for the different view directions. 

 

Isotropic Linear 

If Isotropic Linear is selected, a linear decreasing correlation 

function is used to create the stochastic field. It starts in 0 with 
the value 1. The correlation function reaches 0 in 𝛔 and stays 0 

for larger values. Thus, the gradient is −𝟏/𝛔 between 0 and sigma 

and 0 for larger values. With higher values the features of the 

generated structure become larger. It can be necessary to 

postprocess the results with ProcessGeo Cleanse.  

Anisotropic Linear 

If Anisotropic Linear is selected, different linear decreasing correlation functions are 

used for X-, Y- and Z-direction to create the stochastic field. They are defined as 
described for the isotropic case above. Enter 𝛔𝐗, 𝛔𝐘 and 𝛔𝐙 to determine the 

corresponding gradients: −1/σX, −1/σY and −1/σZ. Higher values lead to larger 

features. It can be necessary to postprocess the results with ProcessGeo Cleanse.  
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In this example, observe the differences in the three view directions  

 

Custom 

A Custom stochastic field is created and segmented to generate the structure.  

If checked the tab Custom Generation Options becomes available. Combine the 
different random field and gradient options in the Custom Generation Options tab. 

This tab can also be reached by clicking Go To Tab in the Generation Mode panel. 

In addition to linear and Gaussian random fields also linear gradient, sphere gradient 

and membrane gradient are available. These options are described in detail on page 

102 ff.  
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THRESHOLDING 

The parameters in the Thresholding panel of the Stochastic Field Thresholding 

dialog define the criterions for the segmentation threshold applied to the generated 
stochastic field to obtain the structure. The available parameters are Solid Volume 

Percentage (%), Grammage (g/m2), Density (g/cm3) or Weight Percentage 

(%).  

 

 

 

 

 

 

 

When Grammage, Density or Weight Percentage are chosen as stopping criterion, 
the temperature must be set as additional parameter in the Material panel. The 

density of the constituent materials will be set with respect to the chosen temperature 

based on the Material Database. 

 

 

When choosing Solid Volume Percentage, the Temperature parameter is not 

available. 

Solid Volume Percentage 

Solid Volume Percentage (SVP) determines the fraction of the total volume in 

percent that the structure should have. Accepted values range from 0 to 100%.  

For example, a structure with a Solid Volume Percentage of 40 consists of 40% 

solid and 60% void space. Porosity is defined as (1 – SVP/100). The threshold to 

segment the stochastic field is chosen to match the given SVP. Observe the difference 
in a structure when varying the solid volume percentage from 5%, to 20% and finally 

to 40%, while all other parameters are left unchanged. 
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Grammage 

The Grammage (g/m2) determines the mass per unit area (in the XY-Plane) of the 

resulting structure. When Grammage is chosen as stopping criterion, the Density 

(g/cm3) of the Bulk Material must be defined in the Material panel and the 

temperature must be set.  

Density 

The Density (g/cm3) of the resulting structure depends on the density of the chosen 

materials, see page 96. It cannot be set smaller than the lowest occurring density or 

larger than the highest occurring density. 

Object Weight Percentage 

The Object Weight Percentage determines the weight of the created object in 

relation to the weight of the whole structure (including the pore material). Choosing 
this option only makes sense when the density of the Pore / Matrix Material is 

greater than zero. Otherwise, the domain will stay empty. See page 24 for more 

information. 

RANDOM SEED 

Random Seed initializes the random number generator behind the stochastic field 

generator. Changing its value produces different sequences of random numbers and 

hence, different realizations of the specified structure. If all settings are equal, 
generating with the same Random Seed value produces an identical structure. 

Random Seed must be a non-negative integer number.  

CUSTOM GENERATION OPTIONS 

The stochastic field and gradient types available for the generation are organized and 
listed in panels. For all objects, the left column of the panel contains the Component 

Type name, the Relative Influence and the Absolute Influence. The absolute 

influence is computed automatically from the corresponding relative influence. 

The resulting combined random field is the weighted sum of all components, where 

the weights depend on the Relative Influence. 

The middle column shows a preview of the defined field or gradient. In the right 
column, the stochastic parameters of the components can be entered. These 

parameters include correlation length, direction vector and perpendicular axis. 
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Isotropic Gaussian is the default Component. At the bottom left of the dialog, clicking 

Add inserts other components chosen from the component pull-down menu. 
Previously saved components with individually defined parameters can be loaded via 

the Load… button.  

Components can be discarded again when clicking Remove in the left panel or can 

be saved as predefined component using the Save… button. 
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COMPONENTS 

The Random Field and Gradient Components are selected from the pull-down 

menu or can be loaded via the Load… button at the lower left of the Custom 

Generation Options tab. 

 

The following table summarizes the components that can be used with GrainGeo 

Stochastic Field Thresholding commands: Isotropic Gaussian, Anisotropic 

Gaussian, Isotropic Linear, Anisotropic Linear, Linear Gradient, Sphere 

Gradient and Membrane Gradient. 

 

Stochastic field Field type Example 

 

Isotropic Gaussian 

 

 

Anisotropic Gaussian 

 

 

Isotropic Linear 
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Anisotropic Linear 

 

 

Linear Gradient 

 

 

Sphere Gradient 

 

 

Membrane Gradient 

 

 

COMPONENT PARAMETERS 

For Isotropic Gaussian, Anisotropic Gaussian, Isotropic Linear, and 

Anisotropic Linear, the parameters in the right column are the same as described 

for Generation Mode on page 98. 
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For Linear Gradient, enter the desired direction vector of the gradient.  

For the default (0,-1,0) the field 
starts with black in the bottom and 

smoothly becomes lighter in Y-

direction. 

 

 

 

 

No parameters can be entered for Sphere Gradient.  

The gradient always starts black in 

the center of the domain and 

becomes smoothly lighter towards 
the borders, resulting in a sphere 

after thresholding, if no other 

components are selected. 

 

 

 

For Membrane Gradient, select the axis perpendicular to the membrane from the 

pull-down menu.  

If, for example, X is chosen, the 

gradient starts as a black plane 
perpendicular to the X-axis in the 

center of the structure. 

 

 

 

Depending on the entered parameters, it might be necessary to change the preview 
direction in the Preview panel on the bottom right of the dialog to see a preview of 

the gradient in the middle column.  
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Using more than one component, the resulting combined random field is the weighted 

sum of all components, where the weights depend on the Relative Influence. 

In this example, a combination of Isotropic Gaussian and Linear Gradient was 

selected. With Rel. Influence of 100 for the Isotropic Gaussian field and 1 for the 

Linear Gradient, observe, how the density of the structure differs according to the 

entered gradient vector (0,1,1).  
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In this example, a combination of Isotropic Gaussian, Linear Gradient and 

Sphere Gradient was selected. With rel. influence of 100 for the Isotropic 
Gaussian field, 8 for the Linear Gradient and 70 for the Sphere Gradient, the 

structure forms a hill with a rough surface. 
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RESULT OPTIONS 

GrainGeo always saves the generated structure as a GeoDict structure file (*.gdt) 
(GeoDict binary data). The file is placed in an automatically created result folder inside 

the chosen project folder (File → Choose Project Folder... in the Menu bar).  

The Structure File as well as the result folder, take the name entered as Result File 

Name (*.gdr) at the bottom of the dialog.  

An additional option to save generation data, is to check Save Random Field (*.gvf) 

to also save the generated stochastic field in the result folder. 

 

 

 

 

This random field can also be loaded from the result file in the Result Viewer. Move 

to the Data Visualization tab and click Solid Volume Fraction (*.gvf).   

 

In the opening dialog click OK.  

 

 

 

 

 

 

 

 

 

 

The visualization of the structure can be turned off by unchecking the Structure tab 

in the visualization panel above of the visualization area in the GeoDict GUI. To learn 
more about the GeoDict visualization settings, e.g. how to change the color of the 

volume field, see the Visualization handbook of this User Guide. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Visualization&release=2023
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The parameters entered in the Stochastic Field Thresholding dialog can be 

saved into *.gps (GPS, GeoDict Project Settings) files and/or loaded from 

them. Remember to restore and reset your (or GeoDict’s) default values 
through the icons at the bottom of the dialog when needed and/or before 

every GrainGeo run.  

Resting the mouse pointer over an icon prompts a Tooltip showing the icon’s 

function to appear. 
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DISTRIBUTE 

When Distribute is selected from the pull-down menu in the GrainGeo section, the 

objects are uniformly spread throughout the structure. Only structures that contain 
analytic information (GAD format) can be used for the distribution of objects.  

To use this feature, the domain must be periodic, and the objects are not allowed to 

overlap. Distribute allows to create a homogeneous structure, for example from piled 

structures created with Pile Analytic Spheres. 

Clicking the Options’ Edit… button opens the Distribute Options dialog 

 

When the desired parameters have been entered in the Distribute Options dialog, 

clicking OK closes the dialog and returns to the GrainGeo section.  

Clicking Generate starts the distribution process. 

 

To save the result of the distribution process, select File → Save Structure As… in 

the Menu bar (see page 67 for further explanations). 

A grain structure containing GAD information must be in memory.  

 

Without a structure in memory, clicking Generate results in an error message. 

 

When the structure is not periodic, an information message appears indicating that 

periodicity will be applied in all three directions and the loaded structure will be 

treated as periodic. The GAD objects are still distributed. 

 

If the loaded structure contains overlap the distribution is not executed and an error 

message appears.  
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In the Distribute Options dialog, Number of Iterations, Shift Distance, and 

Random Seed specify the distribution process.  

Observe the process of distributing the spheres in a 200 x 200 x 200 structure, 

periodic in all directions, generated with GrainGeo - Create with a Voxel Length of 1 

µm, and imported as GAD file. The sphere centers follow a density distribution, which 

results in a layered structure.  

The following values are used here for the distribution process: Number of 

Iterations is 40, Shift Distance is 6 voxels, Random Seed is 4. 

 

 

The Number of Iterations determines how many distribution steps are done. More 
distribution steps lead to a wider distribution of the objects, which is getting closer to 

a uniform distribution. 
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The Shift Distance determines the maximal object movement during a single 

iteration. Large shift distances lead to a longer computing time per iteration. Observe 
the effect of increasing the shift distance from 1 to 4 and then to 10, while the number 

of iterations is kept at 20.  
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SINTER & CRYSTALLIZATION 

With Sinter & Crystallization, virtually sintered and crystallized structures can be 

generated from GeoDict analytic structures (GAD format). The structure is virtually 
compressed until a desired parameter is reached (Sinter Mode). The voxel size in 

the structure decreases, while the number of voxels in the structure remains constant. 

Grains are deformed at their touching points and an Interface Material can be 

added.  

Clicking the Options’ Edit… button opens the Sinter Options dialog to enter the 
desired parameters. Clicking OK closes the dialog and returns to the GrainGeo 

section. Clicking Generate starts the sintering process. 

A structure containing GAD information must be 

in memory. 

 

 

 

 

 

 

 

 

In the Sinter Options dialog, several parameters can be entered to control the 

sintering process: Sinter Mode, Random Seed, Find Grain Interfaces, Interface 

Material, Save Voxel-Geometry with Object Indices, Save Grain Orientation, 

and to Exclude Material, and Exclude Object Type from sintering. 
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Two different stopping criteria for the sintering process can be defined under the 

Sinter Mode panel: 

◼ Shrinkage defines the percentage by which the structure is contracted in each 

direction. 

◼ Solid Volume Percentage: The sintering process continues until the desired 

Solid Volume Percentage is exceeded (Exceed SVP).  

 

 

 

 

 

 

 

 

Observe the effect of increasing Exceed SVP from 20%, to 40% and then to 60%, 

when a structure made of convex polyhedrons is sintered. 
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By default, the structure’s original voxel length is kept (Keep Original Voxel 

Length), which enlarges the solids. Unchecking this option decreases the voxel 

length, while the number of voxels remains constant. 

 

 

Random Seed is a simulation parameter controlling the sequence in which objects 

are sintered. Thus, different random seeds lead to slightly different sintered 

structures. The random seed increases automatically with every sintering process. 

 

If Find Grain Interfaces is checked, the Interface Material of the sintered objects 

can be chosen from the GeoDict material database by clicking the button.  

 

 

 

 

By doing so, a different material ID is assigned 

to the grain interfaces. For example, later 

mechanical properties can be applied just to 
the grain interfaces for deformation or other 

elastic properties simulations with the 

ElastoDict module.  
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To save the geometry information as binary *.g32 format, check Save Voxel-

Geometry with Object Indices. The files in *.g32 format are considerably larger 
than those in GDT format. This file format contains the index of each grain. See the 

GeoDict 2022 Base Reference handbook for more details on these file formats. 

To save the available information about the sintered grains in *.gof format, check 

Save Grain Orientation. This file can be used, together with the structure, to 

compute elastic properties with transversal isotropic or orthotropic constituent 

materials laws with the ElastoDict module.  

If generated, these results can be loaded from the Data Visualization tab in the 

Result Viewer. 

 

One object material ID and/or one object type per structure can be excluded from the 

sintering process when checking Exclude Material or Exclude Object Type and 

choosing the material ID or the object type name from the pull-down menus. 

Exclude Material and Exclude Type can be simultaneously selected to exclude 

objects, that have a certain type or a certain material. For example, exclude all objects 

with material ID 01 and additionally all spheres. 

 

 

 

 

As a simplified example, observe the effect of 

sequentially excluding the Material Polyamide (PA 

66), here ID 02 in gray, or the Object Type sphere 

the during a sintering process of three object types 

made of three different materials. 

 

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en
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GROW SEDIMENT 

When Grow Sediment is selected from the pull-down menu in the GrainGeo section, 

layers of a new material (Interface Material) are added to the original structure.  

Sediments can only be grown on structures that contain analytic information (GAD 

format). 

Clicking the Options’ Edit… button opens the Grow Sediment Options dialog to 

enter the desired parameters. Clicking OK closes the dialog and returns to the 

GrainGeo section. Clicking Generate starts the process of growing sediments on the 

structure. 

A structure containing GAD information must be in 

memory.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the Growth Mode panel, select the growth mode between Exceed SVP (%) or 

Coating thickness (m)). The Interface Material and whether to Save Voxel-

Geometry with Object Indices and to Save Grain Orientation are selected below.  

The amount of the added sediment material on the structure can be controlled either 

by volume percentage (Exceed SVP) or by the Coating Thickness.  
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Observe the effect of increasing Exceed SVP (%) from 20%, to 60% and then to 

90%, when growing sediments on a structure made of spheres. 

 

 

 

A similar effect is observed when selecting the Coating Thickness to be 2.2e-06 m 

(2.2 µm), 1.5e-05 m (15 µm), and 2.5e-05 m (25 µm). 

 

 

The Interface Material of the sediment growing on the structure can be chosen from 

the GeoDict material database by clicking the button. 

The information on the interface material added to the sediments can be saved by 

checking Find Grain Interfaces and choosing an Interface Material. 
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As mentioned above (page 117), the geometry information can be saved as binary in 

*.g32 format or as human readable ASCII *.leS by checking Save Voxel-Geometry 
with Object Indices. The grain orientation can be saved as *.gof file by checking 

Save Grain Orientation. 
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ROUGHEN SURFACE 

When choosing Roughen Surface from the pull-down menu in the GrainGeo 

section, the structure’s surface is roughened. The structure to be roughened must 

already be in memory.  

Clicking the Options’ Edit… button opens the 

Roughen Surface Options dialog. Clicking OK 

closes the dialog and returns to the GrainGeo 

section. Clicking Generate starts the process of 

surface roughening. 

The available units (m, mm, µm, nm, and 

Voxel) are selectable on the top-right of the 

Roughen Surface Options dialog. When the 

units are changed, the entered values are 

adjusted automatically. 

 

From the Roughen Material ID pull-down menu, choose one material to be 

roughened from the materials present in the structure. If the structure consists of 

several materials, each material is treated separately.  

Select Stochastic Roughness or Add Surface Grains as the Method to be used 

for the roughening process from the pull-down menu.  

Random Seed initializes the random number generator behind the surface 

roughening. Changing its value produces different sequences of random numbers and 

hence, different realizations of the surface roughening. If all settings are equal, 

generating with the same Random Seed value produces the identical roughening 

 

 

 

 



GrainGeo –Roughen Surface 

GeoDict 2023 User Guide  123 

Stochastic Roughness 

Stochastic Roughness roughens the surface of the material ID selected with 

Roughen Material ID. This is done by adding and/or subtracting voxels in the 

surface following a stochastic distribution. 

Only the area where the selected material ID (Roughen Material ID) and the 

Background ID touch is defined as surface and thus, roughened. A stochastic field 
is created and segmented depending on the given parameters. It works similar to the 

Stochastic Field Thresholding described on pages 95ff. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the Stochastic Roughness panel, Background ID, Feature Radius, 

Max. Distance and Operation specify the roughening process.  

Change the Feature Radius to change the size of the added and subtracted features. 

The Feature Radius is the 99.7 percentile radius of the features, similar to a 

maximum grain radius. 
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The Max. Distance specifies the displacement of the features from the surface, 

influencing the layer height. If the Maximum Distance is chosen higher than the 
selected Feature Radius, not all features are connected to the surface, unless Check 

Connectivity is selected. 

This can be observed in the following figure on the last structure with a max distance 

of 10 µm and a feature radius of 3 µm. 

If Check Connectivity is selected, all features will be connected to the original 

structure. 

 

Select which Operations should be allowed for roughening. By default, Adding and 

Subtracting features is allowed. But it is also possible to choose Only Add or Only 

Subtract from the pull-down menu.  
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If Add and Subtract is selected, the checkbox Keep SVP is available. Check to keep 

the original solid volume percentage of the structure by using the same number of 

voxels for adding and subtracting. 

 

 

 

 

Add Surface Grains 

Add Surface Grains roughens the surface 

by adding grains on the surface of the of 

the material ID selected with Roughen 

Material ID.  

The next available ID is assigned to the 

grains and the material of the grains can 

be selected from the database after 

clicking the button. For example, if the 
structure contains one material with 

material ID 01, the grains are assigned to 

material ID 02. 

The parameters Number of Grains per 

volume (given in 1/m3) and Radius define 
the number of grains added to the domain 

and the size of the grains added to a 

certain material in the domain.  

 

 

By clicking the Edit... button, the Radius of the grains can be set to be a Constant 
value, or to follow a distribution (Uniformly in interval, Gaussian, Probability 

Distribution, or Log-Normal) as seen above for other parameters (see pages 32ff).  
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When Save Generated Grains as File (*.gad) is selected, a name can be entered 

for the GAD file containing the grains’ analytic data.  

As a simplified example, observe the addition of grains with radius 2 µm to objects 

(box and sphere) with different material IDs. The grains are added in two steps, first 

to material ID 01 (box), and then to material ID 02 (sphere).  

The Number of Grains added is 0.1 grain/µm3 (1 grain for every 10 µm3 of the 

domain).  

For each roughening step, a new GAD file for the grains can be saved, for example 

with the names grains1.gad and grains2.gad. 
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Observe now the effect of adding different amounts of grains with a radius of 3 µm to 

a cube. 

 

 

Finally, observe the effect of always adding 0.1/µm3 grains of different radius (1 µm, 

2 µm, or 3 µm) to the cube. 
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ADD BINDER 

Binder provides structural integrity to structures with grains of all shapes and is, 

therefore, an important processing additive for battery electrodes, grain packs, 

ceramics, and hard-metal sintering processes. 

Add Binder to a structure consists of adding material in the shape of a concave 

meniscus in locations where surfaces in that structure’s material are close together.  

For hollow objects, such as hollow spheres, 

short hollow fibers, and short cellulose fibers 
the algorithm behind needs analytic data 

(*.Add Binder gad format) to discern that the 

empty voxels inside these objects are not part 

of the pore space. Without analytic data, i.e. 

when using voxelized models (*.gdt format), 
binder is also added inside the hollow objects, 

which is physically inaccurate. 

 

 

 

 

 

 

 

Clicking the Options’ Edit… button 
opens the Add Binder dialog. 

Clicking OK closes the dialog and 

returns to the GrainGeo section. 

Clicking Generate starts the 

process. 

 

 

 

 

At the top of the Add Binder dialog, 

the name for the file containing the 
results of adding binder can be entered in the Result File Name (*.gdr) box. The 

default name can be kept, or a new name can be chosen.  

The options are organized into General Options and Binder Distribution accessible 

through tabs.  
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GENERAL OPTIONS 

STOPPING CRITERION 

The user may choose the most appropriate stopping criterion when adding binder. 
The chosen Stopping Criterion interrupts the addition of binder when it is reached. 

The available stopping criteria are Solid Volume Percentage, Weight Percentage, 

and Grammage. 

Solid Volume Percentage 

The binder volume reaches a pre-established Added Solid Volume Percentage (%) 

relative to the total volume. The added material is displayed as a volume amount 

deposited on the structure.  

The Binder Material is assigned to the next available material ID, and the 

appropriate material to be used as binder should be selected from the material 

database by clicking the button. 

 

 

 

 

 

 

 

Weight Percentage 

The weight of binder reaches a certain percentage of the weight of material.  

As seen above for the Solid Volume Percentage stopping criterion, the Binder 
Material is assigned to the next available material ID, and the appropriate Binder 

Material should be selected from the material database by clicking the button.  

It is necessary to set the density for the structure’s material (Material Density) and 

for the binder material (Binder Density) both in g/cm3, as well as the desired 

(weight) percentage of binder material to structure material (Binder Weight 
Percentage, in %). That is, a Binder weight percentage of 20 means that there 

are 20 g of binder added per 100 g of objects in the structure.  
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In the following example, two types of binder (high density: 5 g/cm3 and low density: 

0.5 g/cm3) are added to structure material with a density of 5 g/cm3.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Weight Percentage, when Manual or Undefined are selected, the density of the 

binder is not automatically taken from the database and the user must enter it 

manually (Binder Density [g/cm3]). If this binder material should often be entered 

by the user, it may be saved in the user’s personal database to be selected just by a 

single click. 

Grammage 

The addition of binder stops when the Added Grammage (material and binder, g/m2) 
is reached.  

As seen above for the Solid Volume 

Percentage stopping criterion, the Binder 

Material is assigned to the next available 

material ID and the appropriate material 
to be used as binder should be selected 

from the material database by clicking the 

button.  

 

 

For Grammage, when Manual or Undefined are selected, the density of the binder 

is not automatically taken from the database and the user must enter it manually 

(Binder Density [g/cm3]). If a manual material is used frequently, it is useful to 

save it to the material database. 
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CONTACT ANGLE 

The Contact Angle defines the angle in which the 

binder is deposited in relation to the materials in 
the structure. Values between 0 and 60 are 

accepted. The contact angle helps to optimize and 

realistically model the addition of binder.  

 

 

Observe the effect of adding binder with a 

Contact Angle of 0 or 45. 

 

 

𝑟 

𝛽 𝛽 

Structure 

Binder 

Contact angle 
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BINDER ANISOTROPY FACTOR 

Through the Binder Anisotropy Factor, the user exerts fine control over the 

variation of properties brought on by the addition of the binder due to the variation 
in direction. If the factor is the default value of 1, the binder is distributed isotropically. 

By choosing larger values, the binder is distributed in the XY-plane but then, the 

contact angle value is not accurate anymore. 

Observe the effect of changing the Binder Anisotropy Factor from (the default) 1 

to 3 when adding binder.  

With a binder anisotropy factor of 3, the binder is 

added in the direction of the XY-plane. 

 

 

 

 

 

PERIODICITY 

When the 3D-structure model is periodic in one or more directions, the binder can be 
added periodically: in all directions, only in the selected direction (Periodic X, 

Periodic Y and/or Periodic Z), or non-periodically. Adding binder periodically in 

certain direction(s) only makes sense if the 3D-structure model is periodic in 

that/those direction(s). 

STOP ITERATION BY 

GrainGeo adds binder through an iterative process, which is repeated until the 

stopping criteria is fulfilled. 

The stopping of the iterative process is controlled by checking and setting values and 

for Tolerance, Maximal Iterations, or Maximal Run Time (h). 

Tolerance is the allowable amount of absolute variation between the entered target 

value for the selected stopping criterion (Solid Volume Percentage, Weight 

Percentage, or Grammage) and the value reached by the algorithm.  
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The user may also choose to have the addition of binder stop by a certain number of 

Maximal Iterations or Maximal Run Time (h). 

Information on the stopping of the iterations and the number of iterations can be 

found in the Result Viewer of the *.gdr result file. 

 

APPLY SOLID VOLUME PERCENTAGE / WEIGHT PERCENTAGE / GRAMMAGE CORRECTION AFTER 

ITERATIONS 

Adding binder with the algorithm adds 

binder until the iteration stops 

according to the given stopping 

criterions. Thus, the given value for 

Solid Volume Percentage / Weight 
Percentage / Grammage is usually 

not reached precisely and there are 

few cases, where the algorithm even 

does not converge.  

If the amount of binder should be 
reached perfectly, it can be corrected, 

by checking Apply Solid Volume 

Percentage Correction after 

Iterations, Apply Weight 

Percentage Correction after 

Iterations or Apply Grammage 
Correction after Iterations 

depending on the chosen stopping 

criterion. 

Selecting this option adds or removes 

binder surface voxels after the 
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iterations are stopped till the given binder value is reached precisely.  

Note, that this reduces the Contact Angle precision. 

In detail, if the realized amount of binder after the iterations is larger than the target 

value, voxels are removed from exposed positions, i.e. voxels with only one contact 

to another binder voxel.  

 

In the other case, if the amount of binder is smaller than the target value, the 

algorithm adds voxels on positions with the most binder voxel neighbors.  

 

 

  



GrainGeo – Add Binder 

GeoDict 2023 User Guide  135 

BINDER DISTRIBUTION 

In real life, the process of adding binder to the material is affected by gravity and the 
viscosity of the binder, leading to inhomogeneous distributions. This effect can be 

modeled by defining a distribution of the binder under the Binder Distribution tab.  

The default distribution is Homogenous, but it can be changed to a Density 

Distribution in Z-Direction to allow the modeling of inhomogeneity. 

 

The Number of Rows defines the number of segments in Z-direction. To change the 

number of segments, change the Number of Rows to the number of segments 

desired. 

Z 
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The algorithm tries to reach the desired binder amount for each segment. In each of 

them, the binder is generated separately according to the rules defined in the 
General Options Tab. The Added Solid Volume Percentage / (%) is scaled to 

the normalized density distribution. 

The Binder Distribution can be entered in form of a ratio in the Relative Density 

table.  

In the images below three different segments are discernible with a binder distribution 

according to the relative values given in the table.  
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Clicking the Normalize Button ensures the Relative Density sums up to 1. 

With the Buttons Load… and Save… the Distribution can be loaded/saved as text file 
which can be opened with other software as e.g. Microsoft Excel. 

The parameters entered in the Add Binder dialog can be saved into *.gps (GeoDict 

Project Settings) files and/or loaded from them. Remember to restore and reset your 

(or GeoDict’s) default values through the icons at the bottom of the dialog when 

needed and/or before every GrainGeo–Add Binder run. Resting the mouse pointer 
over an icon prompts a ToolTip shows the icon’s function. 
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GRAIN GEOAPPS 

When Grain GeoApps is selected in the GrainGeo section, predefined structures can 

be chosen from the pull-down menu in the Grain GeoApps panel: Al2O3-ceramic, 
Cordierite-Ceramic, Martensite, DPF 2Layer Ceramic, Metal-Matrix Composite, PZT-

Ceramic, SiC-Ceramic, Water Membrane, and Piling of Complex Objects. 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

ADD GRAIN GEOAPPS STRUCTURES 

During the creation of predefined materials, the corresponding GeoDict macros are 

called and executed. These macros can be accessed through the Open Macro-File 

button; alternatively, they are available in the GrainGeo folder in the GeoDict 

installation folder. They can be opened with a text editor to check or edit the syntax 

of the generation steps. To add GeoApps, put the corresponding macros in this folder 

and restart GeoDict. This action requires admin rights.  

 

EDIT AND GENERATE GRAIN GEOAPP STRUCTURES  

By clicking the Options’ Edit... button, the corresponding parameter dialog opens 

and the parameters defining the 

representative granular structures are 

displayed and can be modified.  

 

 

Click OK closes the dialog. Then, click Run to 

create the structure.  
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GRAIN GEOAPP GALLERY 

All GeoApps can be edited through the Options’ Edit… button. The parameters for 

the apps are shown in their respective dialog. Click Run to create the structure with 

the chosen settings.  
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CREATE GAUSSIAN RANDOM FIELDS 

GAUSSIAN RANDOM FIELD GENERATOR 

A Gaussian random field describes a volume field with correlated noise. This means 

the probability of similarity between two values 

decreases exponentially with their distance. In the 

Gaussian Random Field Generator in GeoDict, 

several Gauss functions can be combined to define a 

random field. 

In the image on the right, a scalar gaussian random 

field in a jet colour gradient is shown. The 

corresponding Gaussian function has a standard 

deviation of 3. 

 

 

 

Gaussian Random field then can be segmented to a structure: 

 

 

In the following example observe different forms of noise.  

   

Uncorrelated noise,  

all values are 

independent 

Noise following a spatial 

correlation. The values 

are correlated with their 

spatial neighbourhood.  

Noise following a spatial 

correlation with a large 

correlation length.  
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The spatial correlation can be specified with an autocorrelation graph. For each 

distance between two voxels the probability of similarity, also called covariance, is 

described. 

In the Gaussian Random Field Generator 

define several autocorrelation functions to 

generate a custom random field. 

 

 

 

 

 

 

To open the Gaussian Random Field Generator, right-click on Volume Field in 

the Project Status section in the left-hand side of GeoDict and select Create 

Gaussian Random Field. 

 

At the top left of the Gaussian Random Field Generator dialog, the name for the 

file containing the generation results can be entered in the Result File Name 

(*.gdr) box. The default name can be kept, or a new name can be chosen, fitting 

the current project. 
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The available units (m, mm, µm, and nm) are selectable from the pull-down menu 

at the top right of the Gaussian Random Field Generator dialog. When the units 

are changed, the entered values are adjusted automatically.  

The Gaussian Random Field Generator dialog is organized using four tabs:  

◼ Options: Determine general properties of the resulting structure, such as size 

and resolution.  

◼ X, Y, Z: Define the autocorrelation parameters for the three axial directions. 

The result files are saved in the chosen project folder (File → Choose Project 

Folder, in the Menu bar). If a GeoDict results file (*.gdr) with the given name 
already exists in the project folder, a warning message is shown at the start of the 

creation process. The user can either decide to back up the old file, to overwrite it, 

or to cancel and choose a new file name. 

OPTIONS 

The geometric properties of the desired random field are accessible under the 
Options tab. The parameters are grouped in the parameters defining the general 

randomness and the Domain parameters. 
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RANDOMNESS PARAMETERS 

If a volume field is loaded, a Measurement Source can be selected. This is useful, 

for example, if a scan with a random field-like structure should be reproduced with 

a different realization of the same statistical properties. Clicking Measure then 

computes the autocorrelation for the volume field values and adds the corresponding 

graph in the X, Y and Z tabs as Measured Covariance. In the Options tab the 

Mean value and the Standard Deviation of the selected field are also entered 
automatically. 

 

If the volume field is not given in the right data type and thus does not show up in 

the pull-down menu, it can be transformed. Therefore, right-click on it in the Project 
Status and select Math Operation. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the Math Operation dialog 

select Convert Data Type 

from the first and Single from 
the second pull-down menu. 
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To generate a new custom random field, enter the desired Mean value and 

Standard Deviation manually. These values correspond to the generated random 

field and define the value range in it. 

 

 
 

In the following observe how the data range changes for different mean values and 
standard deviations while all other parameters are kept the same.  

 

 

Random Seed initializes the random number generator behind the field generator. 

Changing its value produces different sequences of random numbers and hence, 
different realizations of the specified random field. If all settings are equal, 

generating with the same Random Seed value produces the identical random field. 

Random Seed must be a non-negative integer number.  

DOMAIN PARAMETERS 

The Domain panel contains the parameters defining the structure size (NX, NY, and 

NZ) in combination with the resolution (Voxel Length). 

NX, NY, and NZ are the number (N) of voxels in X, Y and Z directions.  

The Voxel Length is the size of one voxel in the chosen units. Varying the values 

for NX, NY, and NZ has the effect of changing the size of the structure in the given 

direction. 

Low values for Voxel Length in combination with high values for NX, NY and NZ 

increase the resolution, but also increase computational time. After setting the 
values of NX, NY, and NZ, and Voxel Length, the physical structure size is 

automatically displayed in the chosen units. If a scan should be statistically 

reproduced, use the same voxel length here. 

X, Y, Z AUTOCORRELATION SETTINGS 

In these tabs the covariances for the corresponding directions are defined. 

Define several autocorrelation functions in the left panel and view a preview of the 

current Generator Input function on the right. The generator input is the sum of 

the defined elements in the Parameters panel and defines the resulting covariance 

for the Gaussian random field.  
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The Side Length defines the length of correlated areas in voxel. The Covariance 

value displays the relative amount of areas with the given side length. 

 

Either Linear or Gauss functions can be added. Select them from the pull-down 

menu in the upper left corner and click . To remove a function, select it in 

the Parameters panel and click  

 

 

 

 

The corresponding graphs are shown on the right with the same name and update 

automatically whenever a parameter is changed. 

The Generator Input then is the normalized sum of all the functions and defines 
the autocorrelation of the generated Gaussian random field. It is also possible to 

combine Gauss and Linear functions. 
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GAUSS FUNCTION PARAMETERS 

In the Parameters panel for Gauss functions, define Standard Deviation and 

Scale.  

Standard Deviation controls the range for Side Length. Note, that the standard 

deviation here directly refers to the corresponding Gauss function, while the standard 

deviation in the Options tab defines the value range in the generated Gaussian 

Random Field.  

Scale controls the range for the Covariance, being a factor multiplied to the Gauss 

function. 

In the following example, observe the impact of scale and standard deviation on the 

graphs. The generator input visualization was turned off by right-clicking in the plot 

and deselecting Generator Input  

To learn more about how to edit plots in GeoDict refer to the Result Viewer User 

Guide. 

 

 

 

 

 

 

 

 

 

 

  

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ResultViewer&release=2023
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LINEAR FUNCTION SETTINGS 

For Linear functions define the intercept of the linear function with the Y-axis (Y0) 

and the X-axis (X0) and multiply this function with the factor given for Scale. 

 

LOAD CORRELATION, GUESS PARAMETERS, IMPROVE PARAMETERS 

While loading the autocorrelation values in the Options tab as described on page 

145 is usually the easiest possibility, autocorrelations can also be loaded from 
GeoDict result files generated with Compute Metrics, available from the Project 

Status by right-clicking on the volume field to analyze. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the Compute Metrics dialog select Minimum, Maximum, Mean Value, 

Standard Deviation and Variance and Autocorrelation and define the 

parameters as needed.  
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For example, if the autocorrelation 

in the current field is different for 

the three directions, compute the 

metrics for each direction. 

Therefore, for Direction select X-, 

Y- or Z-Direction instead of 

Isotropic.  

Clicking Run computes the standard 

deviation, mean value and 

autocorrelation function for the 

chosen volume field. 

 

 

 

 

 

 

In the Gaussian Random Field Generator enter the Standard Deviation and 

Mean manually in the Options tab as given in the Compute Metrics result file.  
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Then, move to each of the X, Y and Z tabs and load the computed autocorrelations.  

Therefore, click Load Correlation and browse for the Compute Metrics result.  

 

 

If an autocorrelation was loaded either from the current volume field or from a 

metrics result, in the plot a graph for the Measured Covariance is added and the 

buttons Guess Parameters and Improve Parameters become available. 
Additionally, below the plot the Error between the measured covariance and the 

current generator input is displayed. It is computed as the sum of squared deviations 

for all data points in the curve. 

 

The number and type of functions needed to fit the measured covariance must be 

defined by the user. After adding the desired number of Gauss or Linear functions, 
clicking Guess Parameters tries different parameters to fit the measured 

covariance. Automatically, the first best guess of the algorithm is entered for the 

parameters.  
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It can be necessary to click Improve Parameters several times, if the Generator 

Input does not fit the Measured Covariance with the desired accuracy 
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After setting all autocorrelation functions as desired for all three directions, clicking 

Run generates the Gaussian random field. 

If the domain parameters are not large enough to represent the given covariances, 

a warning dialog appears. Decide, if the generation should proceed or if it should be 

aborted. Changing the domain size accordingly improves the accuracy.   
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RESULTS FOR GAUSSIAN RANDOM FIELDS 

Generating a Gaussian random field produces a GeoDict result file (*.gdr) and a 

result folder with the same name. Both are saved in the chosen project folder (File 

→ Choose Project Folder… in the menu bar).  

The GeoDict Result Viewer opens for the result file and in the Results – Report 

subtab find the dimensions of the generated field.  

 

 

View the achieved covariances for the three dimensions in the Plots subtab of the 
Results tab. The red graph shows the Achieved Covariance in the resulting 

Gaussian random field. The blue plot shows the Desired Covariance which is the 

Generator Input prepared in the Gaussian Random Field Generator. How many 

numbered plots appear depends on the settings in the generator dialog. Here, the 

desired covariance is the sum of two Gauss functions. 
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The Gaussian Random Field is visualized in GeoDict after the generation but can also 

be loaded at any time from the Result Viewer. In the Data Visualization tab click 

Load Gaussian Random Field and in the Loading Volume File dialog click OK.   

 

To learn more about visualization in GeoDict, refer to the Visualization handbook of 

this User Guide. 

 

This volume field can be transformed into a structure by right-clicking on the field in 

the Project Status and selecting Threshold to Structure.  

 

  

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Visualization&release=2023
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For one threshold, the resulting structure can be previewed in 3D.  

 

 

 

Edit the parameters as desired, and click Run. 
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